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Exploring AF Analytics for Advanced Analysis and Prediction

Course Learning Objectives and ToolKkit

Problem Statement

Secondary transformers deliver electric power to homes and businesses. You have probably
seen one on a pole or pad in your own neighborhood. Utilities monitor energy loads on these
transformers because exceeding designed capacity can cause them to fail, resulting in loss of
service or liability from explosion. Although secondary transformers are not instrumented, their
energy loads can be computed using AF analytics to sum up readings taken from meters placed
at each service delivery point they supply. This summing up, or rollup, analysis has been
completed for the sixty transformers we will be analyzing in this lab.

Since transformer load monitoring is important, our objective will be to develop a simple
statistical model for predicting the power load on each of the sixty transformers operating on
one circuit of our power distribution network. The predictive model will be operationalized to
forecast network loading to anticipate loading problems before they occur. The model will be
developed from utility metering and weather forecast data stored in the Pl archive and
contextualized in Pl Asset Framework (AF).

Learning Objectives

AF Analytics offers distinctive advantages when preparing time-series data for advanced
analytics. It can play an essential role in testing, evaluating and operationalizing developed
models. In addition, the openness of the Pl System supports several different data access
methods, meeting the needs of data engineers or scientists.

In this lab, we’ll complete three exercises demonstrating how AF Analytics can serve as an
advanced analytics workbench. For comparison, we will employ different data access methods,
PI Integrator for Business Analytics and PI SQL Client. (Exercises are replicated in the
Appendix using PI OLEDB Enterprise and the Pl Web API.) Predictive models using Pl Data
will be developed in Python, a readily available open source application that is widely used for
statistical modelling and analysis.

The lab consists of three exercises. The same statistical model is developed in each
exercise, however different features of the PI Infrastructure are used in each case.

+ Exercise 1 - Develop Predictive Model for a Single Transformer
o Data preparation - PI Integrator for Business Analytics (BA).
o Model testing - AF Analytics “Preview Results” — No PI Tags required
o Model evaluation — Microsoft Power Bl
» Exercise 2 - Develop Predictive Model for Multiple Transformers
o Data preparation - PI SQL Client

o Model testing — AF Analytics Backfill — Pl Tags
required o Model evaluation - PI Vision Collections
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+ Exercise 3 - Operationalize Forecast Model for Multiple Transformers
o Operationalization — AF Analytics, Pl Future Data and Pl Vision

Additional data access methods and learning resources are described in the
appendix.

* Appendix A - Example 2 using PI OLEDB Enterprise
* Appendix B - Example 2 using Pl Web API

* Appendix C — Learning Resources

Supporting Pl Infrastructure

The distribution network for the Avenada Central substation in the city of Alajuela, Costa Rica
is represented in the Pl AF hierarchy below. The AF model provides required context, data
preparation, and operationalization support for statistical modelling projects. We will be
focusing on the three-phase (X, Y, Z) Colegio Cientrifico circuit which has sixty pole
transformers.

Our modelling effort requires data from the pole transformer (PT_*) level of the AF hierarchy,
e.g. PY_XYZ20343. Meter data (MTR_*) has been loaded into the Pl Server for the three-
month period, 6/1/17 to 8/31/17. An AF Rollup analytic was used to compute pole transformer
power loads by summing the attribute Wh Delivered Load, for the meters connected to it.

Additional AF attributes have been configured as relevant modelling features. These provide
historical values for the Wh Delivered Load at exactly 7 and 14 days prior to the current time
(Wh Delivered Load - 7d and Wh Delivered Load — 14d, respectively).

Weather conditions in Alajuela are also available in the AF Model and will be used in our
analysis. For this lab, we will be assuming today is 8/31/17. The Pl System contains historical
weather data for ambient temperature, relative humidity and wind speed from 6/1/17 to 8/31/17,
as well as, hourly weather forecast for the upcoming month of September 2017. These values
have been stored in Pl Future data tags.

@ Database [= Query Date - @ @ Q@ Back d, Checkin *) v 2] Refresh 1 New Element -

Elements | PT_XYZ0343

&4 Elements A || General Child Elements Attributes Ports  Analyses Notification Rules

Excluded attributes are hidden.
Rer

7 ¢ 8 &R Name - Value
8 _J Gategory: Asset Specfications
8 _J Category: Derived Measurements

——

=é ¥ Vokage Average 247.58V
neé ¥ Volktage Maximum 24805V

=e # Voltage Minimum 247.32V

=e ¥ Vokage Qualty 206.32 %
LR # Wh Delvered Load 2891 Wh
2 ¥ Wh Delvered Load - 7d 2891 Wh
= # wh Delvered Load - 14d 2891 Wh

| =) Category: Ex. 2 Uinear Regression Mode!
|8 ) Category: Network
|8 J Category: Weather Conditions

=z # Ambent Temperature 67
E] ¥ Relative Humidty 83
= ¥ Wind Speed o mih
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Exploring AF Analytics for Advanced Analysis and Prediction

Software Toolkit

. PI Server 2018 (with the optional RTQP Engine installed to support Pl SQL Client)
. PI Integrator for Business Analytics

. Pl SQL Client 2018

. Pl OLEDB Enterprise 2017 R2

. Pl Web API

. PI Vision

. Python and required package within Jupyter Notebook

. Microsoft Power Bl
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Exercise 1 - Develop Predictive Model for a
Single Transformer

Learning Objectives

» Export transformer load and weather data into a text file using the PI Integrator
for Business Analytics

+ Examine the transformer dataset to gain a better understanding of loading
characteristics

» Develop load prediction model for a single transformer using Python, in Jupyter
Notebooks

» Test the model using AF Analytics “Results Preview” — No Pl tags required.

* Assess model results in MS Power BI

Create an Asset View — Pl Integrator for BA

From the Windows taskbar, open AF Explorer and review the “Distribution Network”
database. We will be using the PI Integrator for BA to create an asset view publication
based on this asset model. The publication target will be a text file posted in the
subdirectory, C:\Users\student01\Python Lab (this is the “Exploring AF for Advanced
Analytics” folder shortcut on the desktop). This text file will provide data for creating the
predictive model in Python.

a. Open the PI Integrator for Business Analytics from the desktop shortcut.

b. Click Create Asset View on the top menu, name your view My Pole Transformer
Loads and click Create View.

Create New Asset View

Asset View Name

My Pole Transformer Loads|

c. Onthe Select Data page, select the Distribution Network database. Expand the AF
Hierarchy to the circuit level and select element Colegio Cientifico. Drag and drop this
element into the Search Shape area in the middle of the screen under Asset Shape.

Select Data > Modify View > Publish

Q) Source Assets

Server ISRVO1 v

Database Distribution Network 3|

@ Assets
4 D Alajuela
4 (3 Avenida Centra
4 (D Transformer 1

» ) Colegio Cientifico
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Exploring AF Analytics for Advanced Analysis and Prediction

d. Expand the hierarchy to expose the phase level and select element X Phase. Drag and
drop this element into the Search Shape area under the Colegio Cientifico element.

Select Data > Modify View » Publish

() Source Assets

Server

Database

@ Assels
4 [ Asjusia
4 (D Avenida Central
4 @ Transformer 1
4 [ Colegio Clentifico

Q) Weather Conditions

)

» €3 X Phase

» ) Y Phase

Select Data > Modify View > Publish

© Source Assets

Server PISRVO1

Expand the hierarchy to expose the transformer level, select element PT_XYZ0343.
Drag and drop the element into the Search Shape area under the X Phase element.

Database Distribution Network

<

© Assets
4 © Alsjuela
4 @ Avenida Central
4 @ Transformer 1
4 [ Colegio Cientifico
& Weather Conditions

4 @ XPhase

] » © PT_XYZ0343

» @ PT_XYZ0379

» ) PT_XYZ0380

f. Use the sort button next to the Attributes filter to group the transformer attributes list by

category.
» @ PT_XYZ0343 ‘
» @ PT_XY20379 F
Attributes | Fifter x ‘
» g Asset Specifications Grouping = ]
Ungrouped

» g Derived Measurements

» g Ex 2 Python Regression Mode!

» g E< 3MATLAB R Model
= egression Model Sorting
» g Network SartAZ

» | Weatner Conations
Sort Z-A

Group by Category

Click the Asset Specifications category and select the attributes shown below. Drag
and drop the group into the Search Shape area under the element PT_XYZ0343.

Attributes | Fitter

]

4 pg Asset Specifications

[i=] Rated KVA

Maximum KVA

5] Loading

|E| Asset ID

el e o e
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h. Click the Derived Measurements category and select the attributes shown below. Drag
and drop the group into the Search Shape area under the element PT_XYZ0343.
4 pg Derived Measurements
& Voltage Quality
 Voltage Minimum
 Voltage Maximum

§ Voltage Average

0 Wh Delivered Load - 7d

‘ Wh Delivered Load - 14d

eeeooc o

& Wh Delivered Load

i. Click the Weather Conditions category and select the attributes shown below. Drag
and drop the group into the Search Shape area under the element PT_XYZ0343.

a [ ] Weather Conditions

& Wind Speed (1]
& Relative Humidity (1]
& Ambient Temperature (1]

J.  The steps above define an Asset Shape for a Single Phase Transformer element
along with its selected attributes.

At this point, only one element is returned in the Match area because

only one transformer element, PT_XYZ0343, has been specified. We

need to leverage our AF Model to obtain data for all the assets we
Tip want to include in our analysis.

T Search Shape
% Asset Shape
4 @ Colegio Cientifico
4 @ XPhase
4 @ PT_XYZ0343
& Ambient Temperature
f=] Loading
=] Maximum KVA
[=] Rated KVA
& Relative Humidity
& Wh Delivered Load
& Wh Delivered Load - 14d

& Wh Delivered Load - 7d

NN NN NN NN NN
¥ X X X X X X X X X X X

& Wind Speed
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Exploring AF Analytics for Advanced Analysis and Prediction

k. Click the edit pencil next to element PT_XYZ0343 and modify the shape filter. Uncheck
the Asset Name and check Asset Template. Select the Single Phase Transformer
template to include all transformers under the X Phase of the circuit. The Matches area
should show a list of 16 elements.

4 (@ Colegio Cientifico a3
4 @ XPhase —
4 @ PT_XYZ0343 j
Edit Filters
[ Asset Name

| PT_XYZ0343

¥ Asset Template

‘ Single Phase Transformer =

LT Asset Category

‘ Single Phase ~

) Add Filter

I. Click the edit pencil next to the element X Phase and modify the shape filter to include
all phases derived from the Phase template. (Remember to uncheck the Asset Name.)

Edit Filters

[] Asset Name

‘ X Phase |

Asset Template

Phase v] |

[T Asset Category

| |

(+) Add Filter

Save

m. With the shape selected and filters set, you should see all sixty transformers listed int he
Matches area.

+ Maiches
Found 60 Matches

» [T Colegio Cientifico
» [T Colegio Cientifico
» [T Colegio Cientifico

3 @ Colegic Cientifico

n. Click the Next button in the upper right corner to proceed to the Modify View page.

11| Page



0. The Modify View page shows a preview of the first 100 rows from the first 10 matches
of the asset shape. Set the time range, 6/15/17 to 8/31/17, to match the available PI
data for the lab. (Since the Wh Delivered -14d attribute returns values from two weeks
ago, we must start the request on 6/15/17 instead of 6/1/17.) Click Apply.

Start Time End Time

61517 ) 8/3117 ﬁ||

p. Click Edit Value Mode at the left side of the top menu.

Select Data > Modify View 2> Publish

o= Add Column Y Edit Row Filters I= Edit Value Mode
12 columns 0 Row Filters Interpolated Values
Ewery 1 hour

Leave the Sampled Values setting defaulted to return interpolated values. However, use
the drop-down menu to select hours instead of minutes samples for each row. Click
Save Changes.

Edit Value Mode

Sampled Values

@® sample values every El minutes «

@® Interpolate @

seconds

OExact @
i minutes
O Use Key Column |Ambient
|

days
Save Changes

g. Click Add Column to add several time columns to the asset view.

Select Data > Modify View 2> Publish

= Add Column Y Edit Row Fiters £= Edit Value Mode
12 columns 0 Row Filters Interpolated Values

Select the Time Column tab and add the columns shown below (the TimeStamp column
is always included by default). Click Display 4 time columns.
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Exploring AF Analytics for Advanced Analysis and Prediction

Add Column

Data Column Time Column

Select Time Column Options for |Local v

Year (2018) TimeStamp (1 ocan
Month (9) Month Name (Local)
Week of the Year (23) Day of the Week (Local)
Day (19) ) Hour (Local)

Minute (57) )

Second (13} d

Milliseconds (250)
UTC Seconds (1537279833.85
UTC Milliseconds
Ticks (836729
Time Zone Offset (420)

Display 4 time columns |

r. Click Add Column again, this time to illustrate a point.

Select Data > Modify View » Publish

o Add Column Y Edit Row Filters

13 columns 0 Row Filters

Select the Data Column tab. Select the Wh Delivered Load attribute and change the
Column Name to Wh Delivered Load Offset. Click Add Column.

Add Column

Data Column Time Column

Select Column Data Source

4 (@ Colegio Cientifico

e

[wh Delivered Load Offsef X

4 [J) Phase

4 (@ single Phase Transformer

# Ambient Temperature
Column Data Content €@

= Loading

- [Value v
=] Maximum KVA

=) Rated KVA Unit of Measure

# Relative Humidity fwatt hour V]
& Wh Delivered Load ‘ Data Type

& wh Delivered Load - 14d Double <]

4 wh Deliverad Load - 7d

4 wind Speed

Add Column
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s. Select the newly added Wh Delivered Load Offset column in the table, set its Column
Offset to be minus 2 hours and click Apply Changes.

My Fole Transtormer Loacs ! ® Column Details
Name
61517 = 83117 Reset Name fo Defaulit
Wh Delivered Load Wh Delivered Load Offset Wh Delivered Load - 14d Data Content
20,953 13643 Value
19,727 12,872
19,281 20,953 12,481 Column Offset
17,885 19727 13,016 —
17,857 19,281 13419
17.343 17.885 11.338 Unit of Measure
17,839 17,857 11,488 T =
19,708 17,343 13,586
21,678 17,839 15,010 Data Type
20,293 19,708 17,612 Gl =
24,100 21,678 14,573
22 529 20,293 14,905
23287 24,100 14,232 Remove Column
26,313 22,529 15,433 1
25,659 23,287 14,246 Apply Changes

The Pl Integrator for BA will return null values for requested values

falling outside the shape’s time range. Fortunately, we have

configured AF attributes to return Wh Delivered Load values for 7 and
Tip 14 days ago.

t. Select the Wh Delivered Load Offset column in the table again. Click Remove
Column, in its Column Details, we're not going to need this.

u. Click Next to proceed to the Publish page.

Start Time End Time
2ek Hour Phase Single Phase Transformer | V=
0 X Phase PT_XYZ0343 [51:] o
1 X Phase PT_XYZ0343 68
2 X Phase PT_XYZ0343 68
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Exploring AF Analytics for Advanced Analysis and Prediction

v. Select Python Lab Folder as the Target Configuration and click Publish, then Confirm
to publish the data as a text file.

Select Data > Modify View > Publish

Target Configuration Summary

Python Lab Folder [v] Shape and Matches

® Run Once

O Run on a Schedule

= Your Start Time is G T17
= Your End Time is 83117

= Your Time Interval gets an interpolated
measurement Every 1 hour

The file name will be the name of the asset view, My Pole Transformer Loads, and it will be
in the subdirectory, C:\Users\studentO1\Python Lab (this is the “Exploring AF for Advanced
Analytics” folder shortcut on the desktop). This target was configured using the
Administration pages of the PI Integrator for BA.

Visual Assessment of Transformer Data

From the desktop, open the Power Bl report called “Example 1 Data Analysis”. The Pole
Transformer Loads text file has been imported into this report to allow visual inspection of
all sixty transformer load profiles. The profiles are presented for the 24 hours of the day and
broken down by the days of the week. Look at transformers, 342, 358, and 416, to observe
some of the differences than can exist. Obviously, we will eventually need to build separate
models for each transformer.
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Python Development Environment

There are many open-source packages that support Python programming. In this lab, we’ll use
the analysis environment contained in the Anaconda distribution of Python. Also included in this
distribution is Jupyter Notebooks. We will be using Jupyter Notebooks as our Integrated
Development Environment (IDE) for the Python work. It is a browser-based environment which
makes it easy to manage program development. This lab contains the following key
components:

* Anaconda 5.1 distribution of Python 3.6
o The Anaconda distribution of Python contains hundreds of commonly used
packages to support python application development and data science
o Jupyter: An interactive notebook useful for annotating python code with
graphics, documentation, or tutorial instructions
» Python packages utilized in this lab - included in Anaconda 5.1
o Numpy: Highly optimized numerical library useful for linear algebra
Pandas: Data management library for DataFrames, similar to R DataFrames
Matplotlib: Visualization library that feels similar to Matlab based plotting
Seaborn: Visualization library with a focus on statistics
Scikit-Learn: Machine Learning library
o json, requests, urllib.parse, requests_kerberos: Support access to Pl Web API
+ Python packages utilized in this lab — not included in anaconda 5.1

o adodbapi: toolkit for interacting with MS SQL and PI via the PI SQL Client and PI
OLEDB

O o0oOoo

Jupyter Notebooks

Launch Jupyter Notebook by clicking once on the icon in the Windows taskbar. You will
see a command window appear - keep this open (minimized) throughout the lab. Eventually,
Internet Explorer will open exposing a list of files in Jupyter’s root directory. Click the link to the
Python Lab folder.

*Jupyter Logout

Files Running Clusters

Select items to perform actions on them. Upload | Mew~ &
Jo -~ MmmJ Name ¥ Last Modified
a month ago
[ Desktop 3 days ago
O 03 Documents 23 days ago
O Downloads 15 days ago
[ Favoriles a month age
8 days ago
O Links a month ago

] Music a month ago

O Pictures a month ago

l [0 3 Python Lab 24 minutes ago I

Saved Games

a month ago

a month ago

a month ago

& months ago
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https://www.anaconda.com/download/
https://docs.anaconda.com/anaconda/packages/py3.6_win-64
https://docs.anaconda.com/anaconda/packages/py3.6_win-64
http://jupyter.org/
http://www.numpy.org/
https://pandas.pydata.org/
https://matplotlib.org/
https://seaborn.pydata.org/
http://scikit-learn.org/
http://kafka-python.readthedocs.io/en/master/

Exploring AF Analytics for Advanced Analysis and Prediction

The Python Lab folder contains the Python scripts files used the lab examples. We will be
returning to it several times. Keeping the browser open will save time in accessing them during
the session.

_ Jupyter Logout
Files Running Clusters
Select items to perform actions on them. Upload  New~= £
[0 |~ Bm] PythonLab Mame < Last Modified
[ seconds ago
[0 & Load Prediction - Example 1.ipynb 19 hours ago
[0 & Load Prediction - Example 2 (Pl OLEDE Enterprise).ipynb 21 hours ago
[1 & Load Prediction - Example 2 (Pl Web API).ipynb 28 minutes ago
[0 & Load Prediction - Example 2.(PI SQL Client).ipynb 21 hours ago

For this lab, you will simply need to know how to step through the Python scripts in a cell by
cell fashion. In Jupyter, this is accomplished by hitting Shift+Enter while focused on a cell. This
will execute the current cell and advance to the next cell. As you execute each cell in the

| Python 3 @ | Python 3 O

notebook, wait for the Python’s busy light to switch from busy, to ready
This indication is in the upper right-hand corner of the Jupyter Notebook. If this is your first time
using Jupyter Notebooks or simply want to learn more, the Jupyter learning resources listed in
Appendix C may be helpful.

Develop the Model in Python

The following code creates a multivariable linear regression model for one transformer. We will
import the transformer data from the text file published by the PI Integrator for B A. Through a
simple cut and paste operation, we will place the model’s equation into AF Analytics and
leverage the AF Analysis Service to test the model. Test results will be exported from AF
Analytics and evaluated using Power BI.

To run the code with your Pl Asset View, you’ll want to replace “Pole
Transformer Loads” with “My Pole Transformer Loads” in the first cell

i of this Jupyter Notebook
Tip

a. From Jupyter, open the Python script, Load Prediction - Example 1.

b. Edit the file_path assignment statement in the first cell to be ‘My Pole Transformer
Loads.txt'
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c. Import transformer data from the text file, “My Pole Transformer Loads.txt” published by
the PI Integrator for Business Analytics. Select the first cell and type Shift+Enter. It
may take a few seconds for the file to be loaded.

import pandas as pd
import numpy as np
import matplotlib.pyplot as plt
import seaborn as =ns #

# Read "Pole Transformer Load.txt™ into the transform

poleTransformerLoads = pd.read csv(file_path,delimiter="

# Print header rowv of dataframe

Empty DataFrame

Columns: [Id, Colegic Cientifico, TimeStamp, Month Name, Day of the Week, Hour, Phase, Single Phase Transformer, Ambi
ent Temperature, Loading, Maximum KVA, Rated EKVA, Relative Humidity, Wh Delivered Load, Wh Delivered Load - 1l4d, Wh D
elivered Load - 7d, Wind Speed, PIIntTSTicks, PIIntShapelID]

Index: []

The column headers returned should match the ones configured in the Pl Asset
View. The columns “Id”, “PlIntTSTicks” and “PlintShapelD” have been added by the
PI Integrator for BA and are for internal use.

d. Rename columns with shorter names. Create a smaller dataframe, modellingData,
containing only the values need for predicting transformer loads. Select the next cell
and type Shift+Enter.

*Single Phase
‘Ambient Temperat

poleTransformerLoad
poleTransformerLoads.rename (columns
poleTransformerLoads. rename (columns
poleTransformerLoads. rename (columns
peleTransformerLoads. rename (columns
peleTransformerLoads. rename (columns
poeleTransformerLoads. rename (columns

{

{ perature'}, inplace = True )
{'Relative Humidity"':'Hu ¥'}, inplace = True )

{'Wh Delivered Load':'Wh Load'}, inplace = True )

{'Wh Delivered Load - 14d':'Wh Load-14d'}, inplace = True }
{'Wh Delivered Load - 7d':'Wh Load-7d'}, inplace = True )
{'Wind Speed':'Wind"'}, inplace = True )

LU L L ({7

modellingData = pol:Trnnsfcmcrima:is [['"Transfo '*TimeStamp"' ; 'Hour', 'Temperature', "Humidity',
'Wind", 'Wh Load', 'Wh Lecad-7d', 'Wh Load-14d']]

# Peek at the first five rovs

modellingData.head()

Transformer TimeStamp Hour Temperature Humidity Wind Wh Load Wh Load-7d Wh Load-14d
0 PT_XYZ0343 6/15/2017 12:00:00 AM 0 68 93.0 7.0 6529.0 32780 2464.0
1 PT_XYZ0343 61572017 1:00:00 AM 1 68 93.0 6.0 6413.0 3220 2798.0
2 PT_XYZ0343 &M15/2017 2:00:00 AM 2 68 93.0 6.0 6781.0 2658.0 2490.0
3 PT_XYZ0343 6/M15/2017 3:00:00 AM 3 68 90.0 0.0 53480 28730 27220
4 PT_XYZ0343 &/15/2017 4:00:00 AM 4 67 930 0.0 6916.0 3306.0 2698.0

The new dataframe, modellingData, contains only data needed for building the
predictive model.
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Exploring AF Analytics for Advanced Analysis and Prediction

e. Examine the last five rows of the dataframe using the tails() method. Select this cell and
hit Shift+Enter.

# Peek at the last five rovs to make sure wve got them all
modellingData.tail ()
Transformer TimeStamp Hour Temperature Humidity Wind WhLoad Wh Load-Td Wh Load-14d
110935 PT_XYZ0414  8/30/2017 8:00:00PM 20 68 730 70 69.0 68.0 440
110936 PT_XYZ0414  8/30/2017 9:00:00PM 21 64 810 30 68.0 68.0 45.0
110937 PT_XYZ0414 8/30/2017 10:00:00PM 22 66 750 30 68.0 69.0 450
110938 PT_XYZ0414 8302017 11:00:00PM 23 65 780 30 67.0 68.0 46.0
110939 PT_XYZ0414 8/31/2017 12:00:00 AM 0 62 860 3.0 68.0 69.0 44.0

f. Gain a simple statistical perspective of the values in our dataframe. Select this cell and
hit Shift+Enter.

modellingData.deseribe().T
count mean std min  25% 50% 75% max
Hour 1109400 11.493780 6925509 0.0 50 1.0 17.00 230
Temperature 1109400  69.853434 8511516 43.0 640 700 76.00 89.0
Humidity 110940.0 69.361259 18.196455 29.0 54.0 7.0 87.00 100.0
Wind  110940.0 6.581908 4486848 0.0 3.0 6.0 9.00 24.0
WhLoad 110940.0 B8475.092098 7452368773 0.0 1970.0 73720 12713.00 57814.0
Wh Load-7d 110940.0 8859.001180 7763.364070 0.0 2063.0 77320 13279.25 57814.0
Wh Load-14d 110940.0 8667.456263 7665040191 0.0 1973.0 7519.0 12951.00 57814.0

g. Generate a correlation matrix of the variables. This will provide statistics on all sixty
transformers as a group. Select this cell and hit Shift+Enter.

# Generate a correlation matrix to check good relatinoships for our model
model corr = modellingData.corr (method
model corr
Hour Temperature Humidity wind WhLoad Wh Load-7d Wh Load-14d
Hour 1.000000 0.431996 -0.478854 0.165933 0.172268 0.177432 0.178858
Temperature 0.431996 1.000000 -0.667318 0.403062 0.318962 0.185169 0.169464
Humidity -0.478854 -0.667318 1.000000 -0.382336 -0.194920  -0.184463 -0.220623
Wind 0.165933 0.403062 -0.332336 1.000000 0.099989 0.120011 0.121844
Wh Load 0.172268 0.318962 -0.194920 0.099989 1.000000 0.843289 0.820274
Wh Load-7d  0.177432 0.185169 -0.134463 0.120011 0.843289 1.000000 0.833011
Wh Load-14d  0.178858 0.169464 -0.220623 0.121844 0.820274 0.833011 1.000000
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h. Generate a correlation chart of the variables. This will provide statistics on all sixty
transformers as a group. Select this cell and hit Shift+Enter.

# Set size of chart

fig, ax = plt.subplots(figsize=(8,8))

# Lets supress some of this i1nfo by masking 1t
mask = np.zeros_like (model corr, dtype=np.bool
mask([np.triu_indices from(mask)] = True

¥ Lets take a g

lew of these correlat

ns .
olwarm', wvmin=-1, vmax=l, linewidths=1l, square=True,

raphical v th at
sns.heatmap (data=model corr, mask=mask, cmap='
annot=Troe, AX=ax)

<matplotlib.axes. subplots.AxesSubplot at 0xe016d49978>
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i. Change the index of modellingData from the “id” column to the “Transformer” column.
Select this cell and hit Shift+Enter.

# In order to analyze transformers individually, ve need to set the datframe's index to the "Transformer” column.
modellingData = modellingData.set_index("Transformer", drop=False)

# Take a lock, see the difference?

medellingData.head()

Transformer TimeStamp Hour Temperature Humidity Wind WhLoad Wh Load-7d Wh Load-14d
Transformer
PT_XYZ0343 PT_XYZ0343 6/15/2017 12:00:00 AM 0 68 93.0 7.0 6529.0 3278.0 2464.0
PT_XYZ0343 PT_XYZ0343 6/15/2017 1:00:00 AM 1 68 930 6.0 6413.0 31220 2798.0
PT_XYZ0343 PT_XYZ0343 6/15/2017 2:00:00 AM 2 68 930 6.0 6781.0 2658.0 2490.0
PT_XYZ0343 PT_XYZ0343 6/15/2017 3:00:00 AM 3 68 90.0 0.0 5348.0 2873.0 27220
PT_XYZ0343 PT_XYZ0343 6/15/2017 4:00:00 AM 4 67 93.0 0.0 6916.0 3306.0 2698.0

With rows indexed by transformer name, we will be able to build a regression models for
one transformer.
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Exploring AF Analytics for Advanced Analysis and Prediction

j. Based on the Power Bl report, we know each transformer’s load profile is unique. Let’s
focus on just one, PT_XYZ0358. Select this cell and hit Shift+Enter.

# Here's hov we can focus on one transformer, say PT XYZ0358.
modellingData.loc["PT_XYZ0358",:].head ()

Transformer TimeStamp Hour Temperature Humidity Wind Wh Load Wh Load-7d Wh Load-14d
Transformer
PT_XYZ0358 PT_XYZ0358 6/15/2017 12:00:00 AM 0 68 93.0 7.0 8439.0 2519.0 3071.0
PT_XYZ0358 PT_XYZ0358 6/15/2017 1:00:00 AM 1 68 93.0 6.0  7596.0 2454.0 2468.0
PT_XYZ0358 PT_XYZ0358 6/15/2017 2:00:00 AM 2 68 930 60 74970 2253.0 2285.0
PT_XYZ0358 PT_XYZ0358 6/15/2017 3:00:00 AM 3 68 900 00 6089.0 22380 2193.0
PT_XYZ0358 PT_XYZ0358 6/15/2017 4:00:00 AM 4 67 93.0 00 6128.0 2530.0 2497.0

k. Generate a correlation chart for PT_XYZ_0358. Select this cell and hit Shift+Enter.

1 # Redo the correlatioin matrix for just PT_XYZ0358.
! model corr = modellingData.loc["PT_XYZ0358",:].corr (method ='pearson’)

fig, ax = plt.subplots(figsize=(8,8))

# Lets supress some of this info by masking it
mask = np.zeros_like(model corr, dtype=np.bool)
mask[np.triu indices from(mask)] = True

# Lets take a graphical view of these correlations.

11 sns.heatmap (data=model corr, mask=mask, cmap='coolwarm', vmin=-1, vmax=l, linewidths=l, square=True,
12 annot=True, ax=ax)

<matplotlib.axes. subplots.AxesSubplot at Oxe017573828>
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I.  Generate linear regression model coefficients for PT_XYZ0358 and print the equation.
Select this cell and hit Shift+Enter. Keep the browser open, we will be coming back to
get this equation.

from sklearn.linear_model import LinearRegression

LinReg = LinearRegression()

# Create dataset of just PT XYZ0358 data.
transformer 0358 = modellingData.loc["PT XYZ0358
LinReg.fit (tIansfcr:‘:Er_EBEE [["Wh Load-7d","Wh Load-14d", "Temperature”,"Humidity"]],transformer 0358 ["Wh Load"])

LinReg.coef [0], "*","'Wh Delivered Load - 7d"' + ",

LinReg.coef_[1], "*" h Delivered Load - 14d' +

LinReg.coef [2], "*", ient Temperature' +",

LinReg.coef [3], "*","'Relative Humidity' +(",LinReg.intercept_, ")" )
Eq:
0.16B26318479599217 * "Wh Delivered Load - 7d' + (0.1781%B8453046811 * "Wh Delivered Load - 14d" + 330.0936897742418
75 % '"hmbient Temperature' + 37.6743301245552 * 'Relative Humidity' +( -19007.071699958319 )

Test Model - AF Analytics Results Preview

Our first Python script has produced a modelling equation for predicting the load on transformer,
PT_XYZ0358. We can use AF Analytics to test the results without using PI tags.

a. Open Pl System Explorer from the Windows taskbar, @

b. Inthe upper left-hand corner select Search, Element Search to open the Element
Search dialog. Fill-in the search criteria matching that shown below, Name: *358*
Template: Secondary Transformer. Click OKk.

Element Search -

Template:"Secondary Transformer” Name: *358% E H Search |
Criteria 2
Name: |‘358x | q Elamentsearch Root: | .| x
All Descendants: |True Vl Template: |Secundary Transformer v‘ ®
Category: |<A\I> v| *®
e Add Criteria ~ [
Results E3
Group by: [ Category [ ] Template
B ) Name 4 Description Category Type Template @
] E[ﬂ FT_XYZ0358 E Single Phase Mane Single Phase Transformer
The search found 1 Element{s) matching the search aiteria.

oK | ‘ Cancel ‘ | Reset
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Exploring AF Analytics for Advanced Analysis and Prediction

c. Under Element Search Results in the AF hierarchy, select element PT_XYZ0358.
Select the Analysis tab and add a new analysis.

Elements
5 Elements General | Child Elements | Attributes | Ports | Analyses ‘Noﬁﬁcah'on Rules | Versi
= § Alajuela )

= & Avenida Central
=-- (§ Transformer 1

4  Colegio Cientifico

Backfilling

>

£, Bement Searches B f9  Ex.2- Predict Load o .
= 1 = fo9  Ex.3 - Forecast Load (V] |

I - ( PT_XYZ0358 I ® @ \Voltage Quality

¥ ¥ 5] @} Voltage Ranges v

J Alternatively, we could have navigated the AF Hierarchy to get to this
Best element but for larger AF structures searching is much easier.

Practice

d. Select “Analysis 1” and change the name to “Test Prediction”.

PT_XYZ0358
| General | Child Elements | Attributes | Paorts | Analyses |Nc1:iﬁmtion Rules | Version |
‘ lﬂ m Mame: Test Pradicticn
o B & & Name Backfilling ~|  Description:
@ m @t Voltage Quality Categories:
@ = @ Voltage Ranges ‘ Analysis Type: (@) Expression
% B @ WhLoad
=) Wty Test Prediction H
W

e. Return to the Python script in Jupyter Notebook and select the load prediction equation
for transformer PT_XYZ0358 Copy it into the clipboard.

10 | # Perform linear regression fit - four terms.

11 LinReg.fit(transformer 035B[["Wh Load-7d","Wh Load-14d","Temperature”, "Humidity"]],transformer 0358 ["Wh Load"])

# Print equation.
print ("Eq:\n", LinReg.coef [Q], "*", "

LinReg.coef [1], "¥
& LinReg.coef_ [2], "*",
LinReg.coef [3],

'Wwh Delivered Load - 7d' + "

","'Wh Delivered Load - 14d' + "

"'ambient Temperature' +",

Relative Humidity' +(",LinRegq.intercept , "}" }

muw o ma
.

75 * 'Ambient Temperature' + 37.6745301245552 *

Relatlve Humidity)

\ Copy [ J

In [ ]:

| Select all

f. Go back to Pl System Explorer and Paste the equation into the “Test Prediction”
analysis.
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Add a new variable

Evaluate
MName Expression

Cutput Attribute
Variablel

9.16826318479599217 * 'Wh Delivered Load -

7d" + @.1781988453046811 * "Wh Delivered Load - 144" + 338.09369774241975 * “ambient Te|Map ‘
©8.16826318479599217 * 'Wh Delivered Load - 7d" + @.17819828453846811 * 'Wh Delivered Load - 14d' + 338.89369774241975 * “Ambient Temperature' +
37.6745301245552 * 'Relative Humidity' £ 10007 azienonn2aa Al

Paste Ctrl+V [ ”

We have designed the Python print statement to align with the

attribute names we have configured int AF, as indicated by green text.
Tip

g. Change the variable name from Variable 1 to Prediction. Click Add a new variable to
add another one.

[ 3
2dd 2 e vari| Ef
5 =
Name Expfpssion Output Attribute
Prediction ©.1§826318479599217 * 'Wh Delivered Load - 7d’ + ©.1781988453046811 * 'Wh Delivered Load - 1ad’ + 330.89369774241975 * "Ambie|Map ®
Variablel Map )

h. Change the new Variablel to Actual and type in the transformer load attribute
‘Wh Delivered Load’. Once you type the first single quote, AF Analytics should provide
a selection list.

Add a new variable

T
Name Expression

Output Attribute
Prediction @.16826318479599217 * 'Wh Delivered Load - 7d" + ©.1781988453@46811 * "Wh Delivered Load - 14d' + 33@.89369774241975 * 'Ambie|Map ®
Actual "Wh Delivered Load® Map ®

Right-click on the “Test Prediction” analysis and click Preview Results.

PT_XY¥Z0358
General I Child Elements | Attributes | Ports ‘ Analyses |Nch‘ﬁaticn Rules | Version |
EIN
e B & & Name Backfilling A
@ a @ Voltage Quality
@ =B @' Voltage Ranges
@ = @ WhLoad _
(1] foa  Test Predictio -
gm New »
S D
| Add a new variable E@ EievemiResults by ‘
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Exploring AF Analytics for Advanced Analysis and Prediction

J- Inthe preview dialog, set the Start Time to 6/15/17 and the End Time to 8/31/17. Click
Generate Results.

Start Time: |6/15/17 EE  EndTime |[sm117 FE [ Generste Results

Actual Wh Delivered Load - 7d Wh Delivered Load - 14d £

Prediction

Trigger Time

6/15/2017 120000 AM| 69241 | 8130 2519 3071 R
6/15/2017 1:0000 AM | 68057 | 75% 2454 2468 S
6/15/2017 20000 AM | 67393 | 7497 2253 2285 "“’3’“5
6/15/2017 3:0000 AM | 66074 | 6089 2238 2193 N
6/15/2017 40000 AM | 64935 | 6128 2530 2497 :1""5}
6/15/2017 50000 AM | 67157 | 6213 3991 2364 Min
6/15/2017 60000 AM | 6821 | 7140 2591 2424 7N
6/152017 0000 AM | 72913 | 5713 3197 3273 78.5ms _'=
6/15/2017 800:00 AM | 80775 | 8761 4077 4418 ‘\n-.q;;/
6/15/2017 90000 AM | 94765 | 8551 4362 6282 4~
B e m o T e )
— S
® Prediction |~
® 5752.93 04052 * 3455 © 8200 620 86 & 4052 575293
30000
25000 ° jg;”;'

&

-5000
6/15/2017 12:00:00 AM 77 days 8/31/2017 12:00:00 AM

Value Scals: @) Single ) Multiple

k. Once you see a completed trend of data, the Pl Analysis Service has finished. Click
Export Results and save the .csv file to the Exploring AF for Advanced Analytics
desktop folder.

»

© + 1 [l ThaPC » Desitop » v ©| [Search Desstog
Organize = New fekder =@
3. Recent places. -
b o
« 1% This PC AP Sciipts
3 Dty L Replay Dats
b & Documents .ﬁzwn 2
» & Downlosds | 9 b2 Predction Evaustion 17/2018 1011 =
P88 Meskc D £ 3 Forecast & Westher
b & Pictures
P 8 Videos . Exploring AF for Advanced Anslytics 102018 049 AM i
b fha Local Disk (€ e way S
b cn Temporary Storage (D) Plintegrator for BA 572017 942 PM
< -
e name: [ Test rediction.15-fun-17-00-00-00_31-Aug- 17-00-00-00.csv v
Save astype: | CSV () v
 Hide Folden [som ][ con ]
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Evaluate Model — Power Bl

Reopen the Power Bl report, “Example 1 Data Analysis”. The “Test Prediction_15-Jun-17-00-
00-00_31-Aug-17-00-00-00.csv” file has been imported into this report. Click the bottom tab
PT_XYZ0358 Model, to see some example analysis of the model test. Looks like there may be
room for improvement, but this will be good enough for this lab’s curriculum.
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Exploring AF Analytics for Advanced Analysis and Prediction

Exercise 2 - Develop Predictive Models for
Multiple Transformers

Learning Objectives

+ Create a view using Pl SQL Client to extract transformer load and weather data directly
from the Pl System.

» Develop load prediction model for multiple transformers using Python, in
Jupyter Notebooks.

» Test and assess this model using AF analytics by backfilling the prediction into PI.

Create a Pl View — Pl SQL Client
@

a. Open Pl SQL Commander Lite from the Windows taskbar,

b. Under the Pl SQL Client branch of the Object Explorer hierarchy, select the
PISRVO01\Distribution Network catalog and click Connect. Once the Data Link
Properties dialog appears, click Ok.

= Data Link Properties -

Connection | Advanced | Al

Data Source

AF Server: | PISRVO1| |

AF Database: | Distribution Metwork ] |

Authentication
Trusted connection

User Name:

Password:

Test Connection

0K Cancel || Hebp
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c. Expand the Object Explorer hierarchy through the Master \ Element \ Table Valued-
Functions path.

Right-click on the Single Phase Transformer_GetSampleValues function and select
Execute Predefined Query... The query’s results will be returned to the grid.

This function was created based on the Single Phase Transformer template defined in
the Distribution Network AF model. Next, we will create our own view to access the data
needed for our Python modelling.

) PI SQL Commander Lite [=Ta 0]

File Edit View Query Tools Help

. MewQuery I Execute 3 |36 | & Query Compendium

Object Explorer + x | [ (5 QuenyTsqi - PISRVOT\Distribution Network 3 -
E 1 SELECT «.Name, <.
a )JDLElE]l‘A Sources. FROM
4 [P OLED Erterprze SELECT TOP 109 1D, Name, Template
J FisRU0Y FROM [Master].[Element].[Element]
a Pt OLEDE Provs ©
L 3 en o v [Master].[Element].[Single Phase Transformer_GetSampledvalues]
4 (JIFiSOL Clent
4 | PISRVOTDtnbution Network
4 [Catalogs
4 [ Masier
_Categary
4 CmBement
“aTables
i Loadrg  MummumKVA  RstedKVA  WwhDakveredLoad  \WhDalivered Load-7d  \wh Defiversd Load - 14d  Ambient Tempersture  Relative Humidity |~
4 [@TableValued Funcions EFEL 5 780 7820 7820 =
e FincElermeres Nz |xs » 820 78 7820
[ElGePiotishcs FIET] ] 820 B2 7820
) B IET P 820 E 7820
[efowsaroncrve - —rm— : =
[ffGecsampledyaiues EFINET] 5 520 B 7820
|!_.L"|d54mrun-s na s 2% '820 B 7820
N P IE 1] ] 820 B2 %20
[l Sincin Phasa Tranwioemae. CotSammelachstione i BE 1 s 820 B 7820
Funce B Execute Predefined Cuery... na WS = 820 B 7820
(v} FERRE = 820 L T80
Torp 3D I EEIES F] 820 E 7820
o na 05 -3 820 B2 7820
Create Function Tabl
i e BEERE L = 520 E R0
- Seripts. um W 2 RN R 7m0
3 Scatar Funchions 7 et
= 3] | Refresh
¥ UDEC Deta Sources @ Query executed successhully PISRVOT\Distribution Network | PI SQL Client OLEDE | 000305268 | 175 rows

d. Make a new Table-Valued Function by right-clicking on the Element folder and selecting
Create Template-specific Data Model... This will open the dialog shown below. Select
the Single Phase Transformer template and click Next.

Template-Specific Data Model 5]

(@ osi

Template Template Type
Data Model Objects @ Element
Summary _) Event Frame
Execution
Template
Circuit
Headquarters

HMM Single Phase Hourly
Meter

A
[ Single Phase Transformar

(= ==
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Exploring AF Analytics for Advanced Analysis and Prediction

e. Next, click Add GetSampledValues in the Data Model dialog.

Template-Specific Data Model ]
(‘ ). 0Sl1

Template Template-Specific Data Model Objects
Data Madel

Objects [ Aad Eement View.

Summary TP
[ Add GeBampledvalues.... |

Execution

Add GetSummaries...

< Back Cancal

f. Atthe top of the Column Definition dialog, uncheck Units of Measure and Error.
Change the Table-valued function name from the default, which has already been
created, to “My Single Phase Transformer_GetSampledValues”. Drag and drop the
attributes shown below to specify the columns we need for analysis. Click OK.

GetSampledValues Column Definition .

Table-valued function name:
My Single Phase Transformer_GetSampledValues
Drag and drop attributes:

<& Ambient Temperature "~ Attribute Value [] Unit of Measure [ Error

féssitrl[} ‘o = |Loading Loading

=4 Coefficient _ .

Cosfficient 1 =l |Maximum KVA Maximum KVA

= —

Coefficient_2 = =l |Rated KVA Rated KVA

=g Coefficient_3 =l |Wh Delivered Load Wh Delivered Load

Intercept =] [Wh Delivered Load - 7d ~ Wh Delivered Load - 7d

Loading =] Wh Delivered Load - 14d  Wh Delivered Load - 14d
MATLAB Forecasted Load

MATLAE Predicted Load =] |Ambient Temperature Ambient Temperature

=4 Maximum KVA =l |Relative Humidity Relative Humidity

Phase = |Wind Speed Wind Speed

Python Predicted Load

=4 Rated KVA h

[[] Show hidden

-~

n >

0K Cancel
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g. Returning to the Data Model dialog, with the new function configured, click Next.
| Tewsespotcomves ]

(@ osi.

Template - Template-Specific Data Model Objects

Data Model - = =

Objects [My Single Phase T X ] [ AddElementView.. |
Summary Add GetSampledValue..
Execution Add GetSampledValues...

Add GetSummary...
Add GetSummaries...

<Back [ MNext»

h. The CREATE FUNCTION has been configured for you. Click Execute to create the
function.

Template Summary
Data Model Objects -
CREATE FUNCTION [Master] [Element] [My Single Phase Transformer_GetSampledValues] 2
Summary (
Execution @ElementiD Guid,
@StartTime DateTime, =
@EndTime DateTime.
@TimeStep String
)
AS
SELECT *

FROM [Master) [Element] [GetSampledValuss]
<
N'Single Phase Transformer, ~Template
{

NiLoading’, -- AttributeTemplatePath
N'Loading!, - ValueColumnName
NULL, -- UnitOfMeasureColumnName
NULL -- ErrorColumnName

N|Maximum KVA',
N'Maximum KVA'
NULL,

1.

[ ook §[ bece |

i. A green Status check means the function is configured. Click Done.

@ osii.

Template ~ Progress
Data Model Objects -
) ( Buationcompletedsuccestly |
E i Details:
Data Model Object Type Name Status
Values Functior My Single Phase T pledValues 4
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Exploring AF Analytics for Advanced Analysis and Prediction

j- Return to the Table-Valued Functions folder in the Object Explorer and find your
new function, My Single Phase Transformer_GetSampledValues. Right-click on it
and select Execute Predefined Query... The following query should appear about
the query viewer.

SELECT e.Name, s.*
FROM

SELECT TOP 10@ ID, Name, Template
FROM [Master].[Element].[Element]

“ROSS APPLY [Master].[Element].[My Single Phase Transformer_GetSampledValues]

e.ID, --Element ID
N'y', --Start Time
N't’, --End Time

N'1h' --Time Step

) s
WHERE e.Template = N'Single Phase Transformer'

k. The default function is limited to 100 rows and its time range is set to yesterday at one-
hour intervals. We will modify this query and save it as a view, so we can get all the
data needed for our statistical model. To start, copy this entire query into the clipboard.

Select the Views folder under Element. Right-click on Views, select Scripts, then
CREATE VIEW, then click New Query Editor Window. The following query will
appear. Replace <view definition> with the query saved in the clipboard.

CREATE VIEW [Master].[Element].[<view nameX]
AS

I.  The following query should now appear in the query window.

CREATE VIEW [Master].[Element].[<view name>]
AS

SELECT e.Name, s.

FROM

SELECT TOP 100 ID, Name, Template
FROM [Master].[Element].[Element]

S APPLY [Master].[Element].[My Single Phase Transformer_GetSampledValues]

e.ID, --Element ID
N'y"', --Start Time
N't", --End Time
N'1h' --Time Step
WHERE e.Template = N'Single Phase Transformer'

m. Modify this query by;
a. Replacing, within the brackets, “<view name>" with “My Pole
Transformer Loads”.
b. Deleting “TOP 100” from the second SELECT statement.
c. Change the Start Time from ‘y’ to “15-jun-2017".
d. Change the End Time from ‘1’ to '31-aug-2017".
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n. When finished with the edits, the query should look like the one below.

CREATE VIEW [Master].[Element].[My Pole Transformer Loads]

AS

SELECT e.Name,

FROM

5.*

SELECT ID, Name, Template
FROM [Master].[Element].[Element]

CROSS APPL)

.ID,

Z2zZ2z2n

"1h'

--Element ID
'15-jun-2017",
'31-aug-2017°,
--Time Step

--Start Time
--End Time

) s
WHERE e.Template = N'Single Phase Transformer'

[Master].[Element].[My Single Phase Transformer_GetSampledValues]

o. Either right-click on the query and select Execute or click on the Execute button on the
top menu bar to run this query and to create the view. You should see the following
message in the Results grid and a green light in the bottom message bar of Pl SQL

Commander Lite.

V [ Results ' _3 Messages

AffectedRowCount

1[-

@ Query executed successfully

p. Return to the Views folder in the Object Explorer hierarchy. You may need to right-click
on the view folder and Refresh it to see your new view. Right-click on the view, My
Pole Transformer Loads, and Execute Predefined Query... The query will return the
first 100 rows of the view.

(<]

File Edit View Query Tools Help

Object Explorer
ek
4 | J) OLEDE Data Sources
4 (E3PI OLEDE Enterprise
J PSRV
4 (@P| OLEDB Provider
J PisRVD1
4 |JPISQL Client
4 |} PISRVOT\Distribution Network
4 [ZCatalogs
4 | ) Master

4 [LaBlement
> [ Tables
4 [dViews
b ()] My Pole Transformer Loads.
()] Pole Transformer Loads
|» [ Table-Valved Functions
b [Function Tables
b [ Templates

e

v X

T CVSNT TSmE
(2 UnitOfMeasure
5 [ Sealar Functions

P1 SQL Commander Lite

) NewQuery | B Execute @ | Z3[EE]E) @ Query Compendium

2y Query2sq - PISRVO1\Distribution Network X

BELECT TOP 100

' Queryl.sql - PISRVOT\Distribution Network

==

Al

FROM [Master].[Element].[My Pole Transformer Loads]

(2] Results |7 Messages |
Wame TimeStamp Losding MawmumKVA RaiedKVA  WhDelivered Load  Wh DeliveredLoad-7d  Wh Delivered Lo ~
1 [PT_XYZ0342 | 2017-06-15000000000 | 365 | 01 10 5 I % 5
2 | PT_XYZ0342 | 2017-06-15010000000 | 365 | 0.1 10 5 an an
3 | PTXYZ0342 | 2017-06-15020000000 | 364 | 0.1 10 ] an an
4 | PTXYZ0342 | 2017-06-15030000000 | 364 0.1 10 E7] 345 an
5 | PT_XYZ0342 | 2017-06-150400:00.000 | 0 01 10 0 o 7
6 | PTXYZ0342 | 2017-06-150500:00.000 | 0 01 10 0 ] []
7 | PT_XYZ0342 | 2017-06-1506:00:00.000 | 0 01 10 0 ] []
8 | PT_XYZ03M2 | 2017-06-1507:00:00.000 | 0 01 10 0 0 []
9 | PTXYZ0MZ | 2017-06-1508:00:00000 | 0 01 10 0 0 []
10 | PT_XYZ032 | 2017-06-1502:00:00.000 | 0 01 10 0 0 []
11 | PTXYZOMZ | 2017-06-1510:00:00000 | 0 01 10 0 0 0
12 | PT_XYZ0342 | 2017-06-1511:00:00.000 | 0 [ 10 0 0 0
13 | PT_XYZ0342 | 2017-06-15 120000000 | 0 01 10 0 0 0

<

>

@ Query executed successfully

PISRVO1\Distribution Network

PI QL Client OLEDB | 00:00:02.749 | 100 rows

g. Edit the query by deleting the “TOP 100” specification in the SELECT statement.
Either right-click on the query and select Execute or click on the Execute button on
the top menu bar to rerun the query. This time you should get all 110,940 rows.
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@ PI SQL Commander Lite [= T

File Edit Vi elp
2 NewQuenfl ¥ Execute @ FAEEHEY @ uery Compendium

Cbject Explorer w x | | By Query2sql - PISRVOT\Distribution Network® X [ [ Query1.sql - PISRVOT\Distribution Network 5
E e SELECT
4 [ JJOLEDS Data Sources ~ FROM [Master].[Element].[My Pole Transformer Loads]
4 {BPIOLEDB Enterprise
J PISRVD1
4 {@P| OLEDB Provider
J PISRVDN

4 [JJPI SQL Chent

4 |4 PISRVOT\Distribution Network [ Results M

“ “J cjﬂ:g:m Narme TimeStamp Loading MaximumKVA Rated KVA  WhDelivered Load  Wh Defivered Load-7¢  Wh Delivered Lo ~
1 [ PT_X¥Z0406 | 2017-06-1500.00.00.000 | 38124 | 522 b3 9531 5423 4949
[ Catzgary 2 | PT_XYZDaDe  2017-06-1501:00:00.000 | 46712 522 2% 11678 6108 B4T9
4 [Element B\ |l 3 [ PT_xrzos06 15020000000 | 5614 522 2% 14035 8334 7622
i Tables 4 | PT_xvZ0406 -06-1503:00:00000 | 44204 | 522 P} 11051 6223 6669
4 Caviews 5 | FT_XZ0406 | 2017-06-1504.00.00000 | 30604 522 b1 7651 10420 10791
_ 6 | PT_XYZD406 | 2017-06-1505.00.00000 | 45164 522 % 11291 16253 18047
My Pole Translommer Londs 7 | PTXvZD406  2017-06-150600.00.000 | 67272 | 522 » 14318 = 11135
()] Pole Transformer Loads 8 | PT_xrZoae 7-06-15 07.00.00.000 | 5062 522 % 12655 6408 8632
4 Table-Valued Functions 9 | PT_xvzn406 1508:00.00000 | 50884 522 2% 12721 5482 11848
3 Function Tables 10 | PT_XYZ0406 | 2017-06-1509.0000000 | 63156 522 P 15789 6626 7478
ool 11 | PT_XYZ0406 -1510:00:00.000 | 78582 | 522 b 19643 484 11494
i Templates 12 | PT_XYZ0406 | 20 1511.00.00000 | 5244 522 ] 13110 12200 16555
[aBventFrame 13 | PT_XYZ0406 | 2017-06-15 1200:00.000 | 62516 622 2% 15629 10657 11580
[ UnitOMMeasure w
i Scalar Functions 2 ; » W——— L — e o001 £5 "
oo v Query executed successfully PISRVO1\Distribution Network | Pl SOL Client OLEDB | 00:00:21.656 | 110940 rows

Develop the Model in Python

The following code creates a multivariable linear regression model for all 60 transformers. We
will use the “adodbapi” package for Python to connect directly to Pl through the view previously
created using the Pl SQL Client. The code will publish coefficients for each modelling equation
to a table in MS SQL. This table will be reference by AF allowing us to easily reproduce these
models through the Single Phase Transformer template.

To run the code with your Pl SQL View, you’ll want to replace “Pole
Transformer Loads” with “My Pole Transformer Loads” in the first cell

i of this Jupyter Notebook
Tip

a. Open Jupyter Notebooks from the windows Taskbar, ©=. Open the Python script,
“Load Prediction - Example 2 (Pl SQL Client)”.

b. In the first cell, change the select statement to 'SELECT * FROM [My Pole Transformer
Loads]'). This will cause Python to access your Pl SQL Client view and create the
dataframe, poleTransformerLoads. Select this cell and hit Shift+Enter. Wait until you
see the table preview before moving to the next cell.
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# EXAMPLE 2 - Create linear regression models for all 60 pole transformers.

# Read PI data via PI SQL Client using the adodbapi package to establisk an OLEDB connection.

4 # Import Python packages.

5 import adodbapi as ado # Support for accessing PI SpL Client - import AF/PI data.

& import pandas as pd # Dataframe support.

from sklearn.linear model import LinearRegression # Linear regression model from the scikit-learn package.

9 # Connect to "Distribution Netwvork Lab"™ model in AF through the PI SQI Client.
PI_connection=ado.connect ("Provider=PISQLClient;Data Source=PISRV01\Distribution Network; Integrated Security=SSPI;")

12 # Create a cursor object to access the data serer for the "Distribution Network Lab"™ database in AF.
13 PI_cursor = PI_connection.cursor()

15 # Select the entire table using the viev configqured in PI SQL Commander.
16 PI_cursor.execute ("SELECT * FROM [My Pole Transformer Loads]")

18 # Extract first row, index=0, to get column names for use as dataframe headers
5 columnNames = [ x[0] for x im PI_ cursor.description]
0 print("PI View column Names=:\n\n", columnNames)

22 # Unpeck the cursor rovs intc a datafraem.
poleTransformerLoads = pd.DataFrame([dict(zip(columnNames, row)) for row in PI_cursor], columns=columnNames)

# Take a look to see if everythking worked.
poleTransformerLoads.head()

PI View column Names:

['Name®', 'TimeStamp', 'Loading', 'Maximum EVA', 'Rated KVA', 'Wh Delivered Load', "Wh Delivered Load - 14d', 'Wh Del
ivered Load - 7d', 'Ambient Temperature', 'Relative Humidity', 'Wind Speed']

" Maximum Rated Wh Delivered Wh Delivered Wh Delivered Ambient Relative ‘Wind

Name  TimeStamp Loading KVA  KVA Load Load - 14d Load - 7d Temperature Humidity ~ Speed

0 PT_XYZ0342 EUIELAR g 01 100 365.0 369.0 370.0 £8.0 930 7.0
00:00:00

1 PT_XYZ0342 e 85 01 100 365.0 3700 3700 63.0 93.0 6.0

2 PT_XYZ0342 SILEEAE g 01 100 364.0 3700 710 £8.0 930 6.0
02:00:00

3 PT_XvZ0342 20170615 45y 01 100 3640 710 3460 £8.0 90.0 00
03:00:00
2017-06-15

4 PT_XYZ0342 roels  am 01 100 0.0 7.0 0.0 67.0 930 00

c. Rename columns with shorter names. Create a smaller dataframe, modellingData,
containing only the values need for predicting transformer loads. Select this cell and hit
Shift+Enter.

# Rename some columns wvith shorter names to make them easier to work with.
poleTransformerLoads.rename (columns = {'Name' :'Transformer'}, inplace = True)
poleTransformerLoads.rename (columns = {'Wh Delivered Load':'Wh Load'}, inplace = True )
poleTransformerLoads.rename (columns = {'Wh Delivered Load - 14d':'Wwh Load-14d'}, inplace = True )}
poleTransformerLoads.rename (columns = {'Wh Delivered Load - 7d':'Wh Load-7d'}, inplace = True )
poleTransformerlLoads.rename (columns = {'Ambient Temperature':'Temperature'}, inplace = True )
poleTransformerloads.rename (columns = {'Relative Humidity':'Humidity'}, inplace = True )
poleTransformerLoads.rename (columns = {'Wind Speed':'Wind'}, inplace = True )
# Define second dataframe with just data needed for our modelling.
modellingData = poleTransformerLoads(['Transformer"', "TimeStamp', 'Temperature', 'Humidity®,
'Wind', 'Wh Load', "Wh Load-7d', 'Wh Load-14d']]
# Peek at the first five rows to make sure things look right.
modellingData.head ()
Transformer TimeStamp Temperature Humidity Wind Wh Load Wh Load-7d Wh Load-14d
0 PT_XYZ0342 2017-06-15 00:00:00 68.0 930 70 365.0 3700 369.0
1 PT_XYZ0342 2017-06-15 01:00:00 68.0 930 60 365.0 3700 3700
2 PT_XYZ0342 2017-06-15 02:00:00 68.0 930 60 364.0 aro 3700
3 PT_XYZ0342 2017-06-15 03:00:00 68.0 900 00 364.0 346.0 ino
4 PT_XYZ0342 2017-06-15 04:00:00 67.0 930 00 0.0 0.0 70
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d. Change the index of modellingData to be the transformer name. Select this cell and hit
Shift+Enter.

¥ rme nally, wve need to

set the datframe's i

modellingData = modellingData.set_index("Transformer”, drop=False)

# Take a lo

modellingData.head ()

Transformer TimeStamp Temperature Humidity Wind Wh Load Wh Load-7d Wh Load-14d
Transformer
PT_XYZ0342 PT_XYZ0342 2017-06-15 00:00:00 68.0 930 70 365.0 3700 369.0
PT_XYZ0342 PT_XYyZ0342 2017-06-1501:00:00 680 930 6.0 365.0 3700 3700
PT_XYZ0342 PT_XYZ0342 2017-06-1502:00:00 68.0 930 6.0 3640 no 3700
PT_XYZ0342 PFT_XYZ0342 2017-06-1503.00:00 68.0 900 0.0 364.0 346.0 ETaR)
PT_XYZ0342 PT_XYZ0342 2017-06-1504:00:00 67.0 930 0.0 00 0.0 70

e. Leverage the connection to Pl SQL Client and Pole Transformer Loads view to get the
list of transformer names. Select this cell and hit Shift+Enter.

mander

PI_cursor.execute ('SELECT DISTINCT Name FROM [Pole Transformer Leoads]')

for row in PI_cursor:

transformerNames.append(row[0])

v tranfomer names list.

print (transformerNames)

['BT_X¥z0406', 'PT_XY20407', 'BT_X¥z0408', 'PT_X¥z040%', 'PT_X¥20410', 'PT_X¥20411', 'PT_X¥20412", 'BT_X¥20413', 'PT_
XYz0414', 'PT_XYz0415', 'BT_X¥20416', 'PT_X¥20416', 'PT_XY20418', 'PT_X¥z0420', 'PT_X¥20382', 'BT_x¥z0383", 'PT_X¥203
84', 'PT_XYZ0385', 'PT_Xv20387', 'PT_XYz0388', 'PT_XY20388', 'PT_XYz03%0', 'PT_XYz0381', 'PT_X¥20382', 'PT_XYz0383',
'PT_XYz0384', 'PT_X¥z0395', 'PT_XYz0386', 'PT_x¥z0397', 'PT_X¥z0398', 'PT_X¥z0399', 'BT_X¥z0400', 'PT_X¥z0401', 'PT_X
¥z0402°, 'PT_X¥z0403', 'PT_X¥z0404', 'PT_X¥z0405', 'PT X¥z0342', 'PT_X¥z0343', 'PT_X¥z0344', 'PT X¥z0345', 'PT_X¥Z034
€', 'PT_X¥z0347', 'PT_X¥z0348', 'PT_X¥z0348', 'PT_X¥Z0350', 'PT_X¥z0351', 'PT_X¥z0352', 'PT_X¥z0353', 'PT_X¥z0354',

'PT_X¥20355', 'PT_X¥20356', 'PT_X¥2z0357', 'PT_X¥20358", 'PT_X¥z0376', 'PT_X¥20377', 'BT_X¥z0378"', 'PT_X¥2037%', 'PT_X
¥20380", "PT_XYZ03B1']

f. Generate linear regression model coefficients for each of the 60 transformers and
write them to SQL. Select this cell and hit Shift+Enter.
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# Using the "adodbapi™ package, to connect to the "Predictive Equations™ MS SCL.

# Set connection parameters.
con_string = 'DRIVER={SQL Server};SERVER=PISRV01;DATABASE=PIWorld;Trusted Connection=Yes;'

# Connect to "Distribution Network Lab® model in AF through the PI SQL Client.
5QL_connection = ado.connect (con_string)

S T R SR

9 # Create a cursor object to access the data serer for the "Distribution Network Lab" database in AF.
10 SQL cursor = SQL connection.cursor()

11

12 # Create linear regression object from the "sklearn™ package we imported earlier.

13 LinReg = LinearRegression()

14

15 # Looping through the trasformer list, Perform linear regression cn each transformer.
16 for transformer in transformerNames:

l"}

18 # Create dataframe for one transformer.

19 transformerData = modellingData.loc[transformer,:]

20

21 # Perform linear regression fit

22 LinReg.fit (transformerData[["Wh Load-7d","Wh Load-14d4", "Temperature”,"Humidity"]],transformerData["Wh Load"])
R

24 # UOpdate asset ID value with the name of this transformer.

25 asset_id = "'"+transformer+"'"

26

27 # Print equation.

28 print (transformer, "Egq:\n", LinReg.coef [0], "*","'Wh Delivered Load - 7d' + ",LinReg.coef [1],

29 **","'Wh Delivered Load - 14d' + ", LinReg.ccef_[2], "*", "'Ambient Temperature' +",

30 LinReg.ccef [3], "*","'Relative Humidity' +(",LinReg.intercept_, ")" )

32 ## INSERT and UPDATE queries to load table for the first time or update an existing one.

33 # Construct query to add this transfamer's model coefficients.

34 insert_query = f'INSERT [Predictive Equations] ([Asset ID], Coefficient 0, Coefficient 1, Coefficient 2, Coeffic
35

36 update_guery = f£'UPDATE [Predictive Equations] SET Coefficient 0O={LinReg.coef [0]}, Coefficient l={LinReg.coef [
38 # Insert this record into the "Predictive Equations™ table.

39 SQL_cursor.execute (update_guery)

40

41 # Commit the queries to write the data into SOL.

42 SQL_connection.commit ()

43

44 # Close database connections.

45 SQL_connection.close()

46 PI connection.close()

PT_XYZ@378 Eq:

©.15878008013229636 * 'Wh Delivered Load - 7d" + ©.17917457192857675 * 'Wh Delivered Load - 14d" + 110.23388419266524 * 'A
mbient Temperature®' + -@.2658384322606984 * 'Relative Humidity' +( -3314.933455710232 )
PT_XYZ8415 Eq:

-0.001099771117482436 * ‘'Wh Delivered Load - 7d' + ©.8@35564537278706055 * ‘Wh Delivered Load - 14d' + ©.85148023700184337
4 * "Ambient Temperature® + -0.8032873513352864587 * ‘Relative Humidity' +( -1.8928457626402812 )
PT_XYZ@4e7 Eq:

©.22133353596481245 * "Wh Delivered Load - 7d" + ©.18948221947528418 * 'Wh Delivered Load - 14d" + 303.2482562187521 * 'Am
bient Temperature' + 7.845152867772784 * 'Relative Humidity' +( -14852.8518428231 )
PT_XYZ@385 Eq:

©.17@33499389382167 * ‘wh Delivered Load - 7d" + -©.13442528680210902 * ‘Wh Delivered Load - 14d' + -8.001806904293367613
* "Ambient Temperature' + ©.802808240581481683 * 'Relative Humidity' +( 10.552971591136941 )
PT_XYZ@346 Eq:

0.14229519100681018 * ‘Wh Delivered Load - 7d" + ©.86105823128834538 * 'Wh Delivered Load - 14d" + 466.02179316494465 * ‘A
mbient Temperature' + 33.496691778996954 * ‘Relative Humidity' +( -26399.777514147783 )
PT_XYZe4e8 Eq:

0.22018154817171823 * 'Wh Delivered Load - 7d" + ©.1723254202743876 * 'Wh Delivered Load - 14d" + 207.3105523807@62 * 'Amb
ient Temperature' + 5.783909412754433 * 'Relative Humidity' +( -8273.493697771371 )
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Test Model - AF Analytics Backfill

a. Open PI System Explorer and go to the Library view. Expand the Tables branch and
click on the Predictive Equations table. Select the Table tab to view the model
coefficients generated by the Python script. Although the script wrote the coefficients to
a MS SQL table, we have imported them into the AF model for use in AF Analytics.

File View Go Tools Help
@ Database [ Query Date - © @ @D Back &) ©, Checkin 3 « (2] Refresh F New Table - Search Tables

IED Distribution Network General | Table | Define Table | version
=

= emplates . .

; @ e Eredictive Equations
Event Frame Templates |ﬁ'!r
Model Templates

- i Transfer Templates

‘Asul]]) Coeffigent_0 Coefficient_1 Coeffigent_2 Coefficent_3 Coefficent_4 Intercept
PT_XY20382 0.07263672 0.002437648 473.7613 67.40076 -24762.5
PT_XYZ0342 0.5932921 0.4004194 0.2417774 0.1231081 -21.13118

PT_XYZ0343 0.04395182 0.09916914 351.8439 20.83276 -18311.89
PT_XYZ0344 0.07994156 0.0909123 602.0067 75.46542 -35513.53

PT_XYZ0345 0.05813053 0.09053257 2457917 25.87701 -14823.33
‘Analysis Categories PT_XYZ0346 0.1423417 0.06116662 466.0056 33.47753 -26359.08
(£ Attribute Categories PT_XYZ0347 0.1096358 0.05748838 645,9308 55,40506 -34972.06

(&) Element Categories PT_XYZ0348 0.1038648 0.133573 2830549 41.00509 -17791.91
(] Motfication Rule Categories T 1 T
(43] Reference Type Categories

FT_XY20349 0.06923891 0.1093802 693, 1084 6073282 -38121.64
‘FT)(YZUBH] VCI. 1187499 0.09494022 ‘295‘1516 | 30.45709 -17761.45
PT_XY20351 0.1488309 0.1010185 3339626 30.93592 -1918L.05
‘FT_XYZDBSZ .0.2333661 0.2792848 .211‘5137 ‘GI‘NQIL -15494.79
PT_XYZ0353 0.1959453 0. 1267081 237,1805 10.61177 -12522.72
PT_XYZ0354 |0.05494547 0.04467159 |22.9388 1921531 -12764.99
PT_XYZ0355 -0‘ 1528177 0. 1859331 | 13%.44% | 2026082 -$309.751
PT_XY2035% 0.1931092 0.07253212 271.1282 13.41234 -14217.23
‘PTJ\’ZUBF .0, 1408201 0.08628307 .227‘5313 | 11,9355 -11773.3

l Predictive Equations Modified:9/12/2018 8:26:00 AM Owner.PISCHOOL\student01 Version: 1/1/1970 12:00:00 AM, Revision 2

b. Return to the Elements view in Pl System Explorer. Select any Single Phase
Transformer element, PT_XYZ... Select the element’s Attributes tab. Find the
attributes under the “Ex. 2 Load Prediction”. Select the Coefficient_1 attribute and
note the used of the Table Lookup Data Reference to make each transformer’s
coefficients available within the element.

File Search View Go Tools Help
@ Database ¥ QueryDate ~ O @ D Back () ® Checkin %) v [&]Refresh | (3 New Element + = New Attribute

Elements PT_XYZ0349
#- @ XPhase ~ ||| General | chid® m’m | Analyses | Notfication Rules | version |
- ﬂ_';&:mw Group by: (V] Category [] Template
- 6 PT_XY20345 Flter £ ~|[] name: Coefficent_0
- @ PT_XY20346 [#¢ 84 R name alvave @ [~ | | Desaroton: Coeff. for Wh - 7d Term |
- @ PT_XY20347 o7 ; 2
~ iyl &7 Wh Delvered Load [13163Wh Propertes: <None> .,J
- @ PTXYZ039 B | @ WhDeivered Load - 7d 13163 Wh Categories: Ex. 2Load Prediction [F]
- @ PT_XY20350
- @ PTXY20351 B | @ WhDelveredLoad - 14d 13163Wh DefadtUOM: | <None>
- @ PT_XY20352 7 value Type: Single
%~ @ PT_XY20353 L .
| @ @ PT_xvz0354 ® |2 Coeficent 0 fo.owm i (006929 ‘
- @ PT_XY20355 epap— | 0212 Reference: [Table Lookup v
- @ PT_XY2035% = T —— Ikl s [ ]
& PT_Xv20357 L] 14] Coefficent_2 693.11 D
- @ PT_XY20358
- & PTXY20378 B 4] Coefident 3 60,733 e |
£ @ PT_XY20385 = | 13 SELECT [Coefficent_0] FROM [Predictive Equations] WHERE [Asset D] =
- @ PT_XY20391 |8 viwoes |z * || “%uEement % ORDER BY Coefficent_0
- @ PT.XYZ0392 /B4 | & Mode Predited Load 12444 Wh
- @ PT_XY20394 =
- B PTXY20400 Bl (2] Category: Ex. 3Load Forecasting 7
- @ PT_XY20401 1 ' B | g Mode ForecastLoad 1760.7Wh | =
— @ PT_XY20904 . !
i @ PT_XY20420 v |[|B (2 category: Network
) Bements ® | Eiphase |¥Phase
Event Frames . =l substaton Alajucia
) Library B (2 Category: Weather Conditions
Unit of Measure s om & Ambient Temperature 45degF
88 Contacts U & Relatve Humidity 83%
Management ) B | & wedsosed omm | v || bmis Eorccsls
Coefficient 0
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c. Select the element’s Analyses tab. Select the Ex. 2 — Predict Load. Here the linear
model developed in Python has been expressed in terms of AF Attributes. This
expression was configured as part of the template used for all Pole (Single Phase)
Transformers.

Fle View Go Teols Help

@ Dstabase [ Query Date - ® @ [P Back ) |H, Checkin %) v (g Refresh g New Template ~ Search Element Tempiates 2 ~
||| General | Atiriute Tempistes | Ports | Analys Temviates | Hosfication Rule Templates |
& ‘ Name: Ex. 2 - Predict Losd A
Dezerpon Linear Regression developed n Bython.
b 2- Pradict Load [f | cogones [Bamped ~|a
® Expression Rolup
n @ Voltage Gusiy Al TIPS ) vt Frame Ganenton ) SC
@ Voltsge Ranges <1 7] Enable anslyses when crested from template v
Example Blement:  AlustaAvenida Central T ansformer T\Colegeo CientificolX Phass!\9T XYZ0343
2k 2 e variable vt
Name Expresson Qutput Attribute
Presiction| ‘Costictent 8" = "W Delivered Losd - 74° + "Cosfficient 1 * "W Delivered Moo Pesctealons|
‘Coefficient_@" * ‘wh Delivered Load - 7d° + ‘Coefficient_1° * “wh Dalivered Load - 14d" &

"Coefficient 2 * ‘Ambient Tempersture’ + 'Coefficient 3’ * 'Relatije Humidity’ +( Intercept’) .

.Sﬂm () Bvert-Triggered @) Periodic
Periodk 01h Dm 00s

Single Phase Transformer Modified:1/18/2019 53401 AM OwnerPISCHOOL \studentd!

d. Next, we will use the backfilling feature of AF Analytics to populate he result of the
predictive model into Pl points configured for all 60 transformers.

Go to the Management view in Pl System Explorer (icon in lower left-hand corner).
Select Example 2 Prediction under Analysis Searches. This allows us to manage just
the AF Analytic configured for Example 2 of the lab.

File View Go Tools Help
@ Database [ QueryDate - @ @ DBack ) ©, Checkin ¥} « [2] Refresh
Analyses
‘total cted (0 on this ) 1 - 60 of 60 LIL ‘Operations
[] sus @ 8 Element Hame: Template. Baddilling Enable | Disable selected analyzes
- 0 e oo Alajusls\venida Central[Transformer 1\Colego Cientlico|Z Phase\FT XVZ0382 Bx.2-Predictload  Ex.2- Predict Losd (2] st | Gsbic sutomtic recakaation for seected
Anelysis Searches. O & Jo Mlajuela\tvenida Central Transformer 1\Colegio Cientfico|2 Phase\FT_W20376 Ex. 2 - Predict Load  Ex. 2 - Predict Load anahyses
+ X [N Foo Mlapuela\avenida Central|Transformar 1\Colego Ciendfico|Z PhaselPT_XvZ0342 Bx.2-Predictioad  Ex.2 - predit Load Bkl Rociciats sclctad andhaca
Al o0 & e Alejucla\avenids Centrel|Transformer 1\Colegio CientificolY PhaselPT_XVZ0958 Ex.2 - Predict Load  Ex.2 - Predict Load
Enatied - O & 4 Mlzwela\dvenida Central\Transformer 1\Colegio CientiicolY Phase\PT_XV20352 Ex. 2 - Predict Load Ex. 2 - Predict Load Start
L [m) o Mlajuela\ivenida Central|Transformer 1\Colegio Cientifico\Y Phase\PT_XYZ0351 Ex. 2 - Predict Load Ex. 2 - Predict Load End ’W
0o e i i 11Colegio Cientificol PRese\FT_XY20350 Ex. 2 -Predict Lood  Bx. 2 Predict Lood .
Examgle 2 Prediction o W[ @& fe4 Mlzjuela\hvenida Central|Transformer 1\Colegio Clenticoly Phase\PT_Xv20349 Ex. 2 - Predict Load Ex. 2 - Predict Load i ‘!'{KLS"N“ ";_.‘dﬂm :‘;"ﬁ"“ﬂ data?
TN} b Mlajusla\Avenida Cantral|Transformer 1\Colegio ClentificolY Phass\FT_XYZ0348 Ex. 2 - Pradict Load Ex. 2- Predict Load A p::a::mrien m"g";:':m —
O @ fo Alajucla\avenida Central Transformer 1\Colegio Cientficol Phase\PT_XYZ0347 Ex. 2 - Predict Load  Ex. 2 - Predict Load [ Racalniata dapendant angiyses
[N oo Mlapuelalvenida Central|Transformer 1\Colegio Ciendficoly Phase\fT_XvZ0346 B 2-Prediiload  Ex.2- PredictLoad -
o @ o9 Alajucla\tvenics Ceniral|Transformer 1Colego Cientificoly Phase\FT_VZ0345 Ex.2 - Predict Load  Bx. 2~ Predict Load 0 Queue
[m} fei AlajuelalAvenida Central|Transformer 1\Colegro Cientficol Phasel\PT_XV20344 Ex. 2 - Predict Load Ex. 2 - Predict Load
0 @ foo | Alajuslaltvenida Central|Transformar 1\Cslegso CientiieolX Phase\PT_XVZ0379 | B 2 - Prediet Load Ex. 2 - Prediet Load H e et e i
O & o4 Alajucla\dvenida Central\Transformer 1\Colegio Cientificoly PhasciPT_XV20420 Ex.2- Predict Load  Ex. 2 - Predict Load
(W) I 1iColegio ClentiicolZ Phase\PT_X¥Z0402 £x. 2 - Predict Load Ex. 2 - Predict Load L= s
0o e fob | Mlejucla\tvenida Centrel\Transformer 1Colegio CientficolX Phase\PT_XYZ0388. Ex. 2 - Predict Load Ex. 2 - Predict Losd o peading paration
O & oo Alaiela\avenida CentrallTransformer 1\Colegio Ciendficol Phase\PT_XYZ0400 Ex. 2-Prediceload  Ex. 2 - Predict Load
[m) oo Mlajuela\Avenida Central| Transformer 1\Colegio Cientifico\Z Phase\PT_XVZ0389 Ex. 2 - Predict Load Ex. 2 - Predict Load
o e ¢4 Alajuels\tvenica Central|Transformer 1\Colegio CientificolY Phass\PT_XVZ0353 Bx.2 - Predict load B 2 - Predict Load
(M} fe lapuela\avenida Gentral|Transformer 1\Colegio Clentifico\Z Phase\PT_Xv20398 Ex. 2 - Predict Load £x. 2 - Predict Load
0 e I Central|Teansformer 1\Colegio Cientficol) Phase\PT V20343 Ex.2-Preditload  Ex.2- Predict Load
[mi) b Alajuela\Avenida Central|Transformer 1\Colegio Cientificol)t Phase\PT_XY203%0 Ex. 2 - Predict Load Ex. 2 - Predict Load
3 Elements [N Joo mlapuela\avenida Central|Transformar 1\Colegro Cientfico|Z PhaselpT_XvZ0909 B2 -Predictioad  Ex.2 - predict Load
Fvent Frames 0 @ e Alejucla\avenids Centrel\Transformer 1\Colegio CientficolY PhaselPT V20984 Ex.2 - Predict Load  Ex.2 - Predict Load
O @ fs Alapueia\ivenida Central| Transformer 1\Colegio CientficolZ Phase\PT_XVZ0414 Ex.2 - Preditload | Ex.2 - Predict Load
Libeary O e fo4 | Alajuclalvenida Central|Transformer 1\Colegio CientificolZ Phase\PT_XY20384 Ex. 2 - Predict Load Ex.2 - Predict Load
Unit of Measure () e Alnjucla\dvenida Centra\Transformer 1Colegio Cientficol¥ PhasciPT XVZ0404 Bx. 2 - Predict Load B 2 - Predict Load
O @ oo Mlajuela\Avenida Central|Transformer 1\Colegio Clentfico\Z Phase\PT_XVZ0408 Ex. 2 - Predict Load Ex. 2 - Predict Load
0 @& 63 Msjusts\dvenids Central|Transformer 1\Colegio Cientificol Phase\PT_XYZ0391 Ex. 2 - Predict Load Ex. 2 - Predict Load
k] i) M 1iColecp CientficolY Phase\PT 20385 Bx,2 - Predics lpad 2 - Predict Load -
o |
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e. Check the Status box at the top of this column to select all transformers and click
Enable to start this group of 60 analytics.

File View Go Tools Help
@ Datsbose [ QueryDate + © @ QBack ) H, Checkln 3 v [g] Refresh
| Management
Choose a type d (60 on this page) 1-600f60 <>,
gt — 5 x d=3 mns
i ikt Eement Name Template Badkfilng e | Dbl sccted nsyes l
AS i~ Phase\PT_XYZ0382 Ex. 2-Prefictload Ex.2 - Predit Load
Analysis Searches ) oo Phase|PT_XYZ0376 Ex. 2 - Predict Load Ex. 2 - Predit Load analyses
+ X 9 o olegi _XY20342 Ex. 2 - Predict Load Ex. 2 - Predict Load e e ooy roys o
] - 9 S Phase\PT_XYZ0358 Ex. 2 - Predict Load B 2 - Predit Load
Enabled > 9 S Phase\PT_XYZ0352 Ex.2-Predictioad Ex.2-Predkt Load Start [6/15/2017 12:00:00AM o
v @ foo 1\C Phase\PT_XYZ0351 Ex. 2 - Predict Load Ex. 2 - Predit Load nd [8BY207 120000 A PR
Dhetind @ /@ @  f saweavivends Cenalirransiormer 1\Colegio Gentficoly Phase\fT_XYZ0350 Ex.2- Predit Load  x.2 - Predict Load -
Eanple2Predicion. > (1] @ S 1\ PhaselPT_XYZ0349 Ex. 2 - Predict Load Ex. 2 - Predict Load muﬂ:!““hmqum-’
Bampesroeant o (|M @ 1ic PhaselPT_XYZ048 Ex.2-Predictload  Ex.2- Predet Load - B m‘:"“um“:’:'dm“
) [ 1 Phase\PT_XYZ0347 Ex.2-Predictlosd Ex.2- Predut Load " [ Recaklate dependent analyses
v @ foo Alajuela\Avensda CentrallTransformer 1\Colegio Gientifico\Y Phase\PT_XYZ0346 Ex. 2 - Predict Load Ex. 2 - Predict Load
¥ @ w0 Phase\PT_XYZ0345 Ex. 2 - Predict Load Bx. 2 - Predit Load E
9 S Phase\PT_XYZ0344 Ex. 2 - Predict Load Ex. 2 - Predict Load
~ @ oo PhaselPT_XYZ0379 Ex.2-PredictLoad  Bx.2- Predit Load [ FSEReatc w8 Pocmansnty Ssete s thx'
~ 9 ~» 11C ithicoly Phase\PT_XYZ0420 Ex.2-PredictLoad Ex.2- Predit Load
Mo M 1ic Phase\PT_XYZ0402 Ex.2-Predict load  Ex.2 - Predit Load f | Fenon Onerations
& @ fo PhaselPT_XY20388 Ex.2- Predict Load  Ex. 2 - Predit Load Enabling 60 analyses Dismes
¥ @ S Phase\PT_XYZ0400 Ex. 2 - Predict Load ©x. 2 - Predit Load Tne submitad: 12/20/2018 11:57:59 A
9 S \Coleg Phase\PT_XY20399 Ex. 2 - Predict Load Bx. 2 - Predit Load Qe by EOROLMeR S
¥ @ oo Phase\PT_XY20353 Ex.2- Predictload  Ex. 2 - Predict Load @ conglies
&4 9 fto Alayuela\Avenida Central\Transformer 1\Colegio Centifico\Z Phase|PT_XYZ0398 Ex.2 - Predict Load  Ex. 2 - Predict Load
& 9 fto Alajuela\venida Central\Transformer 1\Colegio GentiicolX Phase\PT_XYZ0343 Ex.2 - Predict Load Ex. 2 - Predict Load
v @ o 1{Colegio Centifico\X PhaselPT_XYZ0390 Ex.2- Predict Load  Ex. 2 - Predict Load
7 Hements v & Sto Mlajoeia\Avensda Central\Transformer 1\Colegio CentificolZ Phase|PT_XYZ0409 Ex. 2 - Predict Load Bx. 2 - Predxt Load
| Event Frames ¥ @ fo Alauela\Avensda Central\Transformer 1\Colegio CientificolY Phase\PT_XY20394 Ex. 2 - Predict Load Ex. 2 - Predict Load
& 9 fo 1\Colegio Centfico\Z Phase\PT_XYZ0414 Ex.2-Preditload Ex.2 - Predit Load
Aoy ¥ 9 ™ Phase\PT_XYZ20304 Ex.2-Prodictload  Ex.2- Predit Load
Unit of Measure ¥ @ o 11Col Phase\PT_XYZ040A Ex.2- Preditload  Ex. 2 - Predct Load
|8 Contacts v @ fo 1\Coleg Phase|PT_XYZ0408 Ex. 2 - Predict Load x. 2 - Predit Load
T v @ foo 1\Colegi Phase\PT_XYZ0391 Ex. 2 - Predict Load Ex. 2 - Predit Load
X i~ (™ 16 Phase\PT XY20385 Ex.2 - Prodictload  Ex.2 - Predictioad v
Analyses

% |

f. Set the Backfill Start and End times to 6/15/17 and 8/31/17, respectively. Check
Permanently delete existing data and recalculate. The click Queue button to start
the Backfill operation.

File View Go  Tools Help
@ Database [ QueryDate - © @ | @ Back ) &, Checkin *} « (2] Refresh

Management Analyses

Choase a type: 60 total analyses selected (60 on this page) 160080 <[5]  operations

® Analpes Stots @ B Element Meme Template. Backfiling E0abli | Disable selected anaiyses

) Hobfication Rules

14Colegio Cientfico\Z Phase|PT (120382 Ex. 2 - Predict Losd Ex. 2 - Predict Load 2 [ r— -

Analyss Searches Alsjueis\Avenids CentraliTransfomer 1\Colegio CoentRicolZ PhaselPT_XYZ0376 £x.2- Predktiosd  Ex.2- Predict Losd v — .
+x Alajuela\Avenida Central\Transformer 1\Colegio Clentico\Z Phase|PT_XYZ0342 Ex, 2 - Predict Load  Ex. 2 - Predict Load Gackiil/Recalcuate selectad naiyses
- P Alsjuets\Avenida Central|Transformer 11Colegio Cientfico\Y Phase\PT_XYZO3S8. Ex. 2 - Predict Losd Ex. 2 - Predict Losd

Enshied - Alajuels\Avenida Central\Transformer 1\Colegic Cientfico\Y Phase\PT_XYZU352 Ex. 2 - Pradict Load Ex. 2 - Predict Load st [G15/2017 iz00:00 00 P

) Alaiuets\Awenids Central\Transformer 1Colegio Clentficoly Phase\PT_XYZD351 Ex. 2 - Predict Losd Ex. 2 - Predict Load = mwm; 12:00:00 AM.
Disatied - Alajuela\Avenida Central\Transformer 11Colegio Cientifico\Y Phase\PT_XYZ0350 Ex. 2 - Preduct Load Ex. 1 - Predict Load

Example 2 Prediction " Alsjuels\Avenids Central\Trancformer 1\Colegio Cientfico\¥ Phase|PT_XYZ0348 Ex. 2 - Pradict Losd Ex. 2 - Predict Losd What should we: do with existing data?

. 8 = ) Leave existing data and fill in gaps.

Example 3 Forecast ra Alajusls\Avenida Central\Transformer 1\Colegio Ciantifico\Y Phase\PT_XYZ0348 Ex. 2 - Predict Load Ex. 2 - Predict Load

(@) Permanently delete existing data and recakculste

Alajuela\Avenida Central\Transformer 11Colegio Cientfica\¥ Phase|FT_XYZ0347 Ex. 2 - Predict Load Ex. 2 - Predict Load 7] Reclclate dependent an

Alajuela\Awenida Central\Transformer 11Colegio Cientfica\¥ Phase|FT_XY20346 Ex, 2 - Predict Load Ex. 2 - Predict Losd
Alsjuels\Avenids Central\Transformer 1\Colegio CientficolY Phase|PT_¥Y20345 Ex. 2 - Prafict Losd Ex. 2 - Predict Losd
Alajuela\Avenida Central\Transformer 1\Colegio CientficolY Phase|PT_{YZU344 Ex. 2 - Predict Load Ex. 2 - Fredict Load

LiGolegio [ XZ0379 Ex2-Predktload  Ex 2 - Predict Load Eabiiab nl e ane e delan Al B L
Alsjuela\venida CentralTransformer 1{Colegio CientficalY PhaselFT_X1Z0420 Ex. 2 - Fredict losd  Ex. 2 - Predict Load
Alajuels\Avenids Central\Tranchormer 1\Colegio Cientfico\Z Phass|PT_(YZ0402 Ex. 2 - Pradict Load Ex. 2 - Predict Load Peading Operations
[pismiss|

Alajuela\Avenida CentrallTransformer 11Colegio CienticolX Phase\PT_XYZ0388 Ex.2-Predictload Ex 2 - Predict Load Enabling 60 analyses
. . Time submitted: 12/20/2016 11:57:59 A
lajuaAvenkda Contral Transfomer 11Colglo CenticoY PhaselPT (20400 Ex. 2 - Prodict Load  Ex.2 - Predc Load e s 2
1iColegio \PT_YZ0399 Ex. 2 - Predict Losd  Ex. 2 - Predict Losd °

‘Alajuela\Avenida Central|Transformer 1\Colegio CientficolY PheselPT_XYZ0353 Ex. 2 - Predict Load Ex. 2 - Predict Load
lajuelalAvenida Central|Transformer 1\Colegio Cientfico|Z Phase|PT_YYZ0398 Ex. 2 - Predict Load Ex. 2 - Predict Load
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1i€olegio _XVZ0343 Ex. 2 - Predict oad  Ex. 2 Predict Load
Alsjuels)\Avenids Central|Transformer 1\Colegio Cientiicol Phase\FT_XYZ0390 Ex.2-Fredictlosd Ex.2 - Predict Load
9 Eements ‘AlajuelaAwenida Central|Transfoemer 1\Colegio Cientfico|Z Phase|PT (V20409 Ex.2 - Predict Load  Ex.2 - Prediet Load
r—r—— Alajuela\Avenida CentrallTransfomer 1\Colegio Cientiicol¥ PhaselPT_XYZ0394 Ex.2 - Predict Load  Ex.2 - Predict Load
1\Colegio Clentfico\Z Phase|FT_XY20414 £x.2- Predictiosd  Ex.2 - Predit Load
L— i t 1iColegio CientficolZ Phse|PT_XY20384 Ex.2 - Predictlosd  Ex.2 - Predict Losd
Unit of Measure ‘Alsjuels Awenida Central|Transfoemer 1\Colegio Cientficol¥ Phase|PT_XVZ1404 Ex.2 - Predict Load  Ex.2 - Prediet Load
8 Contacts Alajuela\Awenida CentrallTransfomer 11Colegio CienticolZ PhaselPT_XYZ0408 Ex.2 - Predit(oad Ex.2- Predict Load
Alajucka)\Avenids Central\Transformer 11Colegio CientRicolY Phase\PT_X1Z0391 Ex.2 - Predictlosd  Ex.2 - Predict Lusd

® T Coleio Genbficl PhoaelPT 120385 £, Profictioad £ Predict Load o

Anshyzes
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g. Once all 60 analyses have been backfilled, click Disable to stop them. We are only
testing our new model over a controlled time range. It's not ready for general use yet.

I!i. View Go Tooks Help
@ Database [T QueryDate + © @ QBack ) H, Checkin %3 v [§) Refresh
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| Management
Choose a type 60 total analyses selected (60 on this page) 1-600f60 <[5
B dndptes s [ Statws © B Element Enai | Dusatie selected snayses
¥ 9 foo Alapuela\avenida Central\ Transformer 1\Colegio Clentfico\Z Phase\PT_XY20 SURAES
Analysis Searches ¥ & foo Alagjuela\Avenida Central\Transformes 1\Colegio Cientfico\Z Phase!\PT.
* X 2 9 ™ WMATWIWWWEJ RackfiRacaicidste selected anaiyses
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-2 © foo Alapuela\ivenida Central|Transformer 1\Colegio Clentifico\Y Phase\PT. A ;IS';_IBZE
v 9 S Alapuela\avenida Central\Transformer 1\Colegio CientficoY Phase\PT —_—
Dleaklod * e @ foo Alajuela\Avenida CentralTransformer 1\Colegio Cientfico\¥ Phase\PT_XYZO B |  what showld we do with existing dats?
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¢ 9 foo  Alapela\avenida Central\Transformer 1\Colegro ClentiicolY Phase\PT_XY20
b9 M A\calagie CantiicalZ Phass\PYXY2H hm“wu.“xrwwukuasm Do
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v 9 feo Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XY20 +
| - 1 )
Analyses




Exploring AF Analytics for Advanced Analysis and Prediction

Evaluate Model — PI Vision Collection

P1 Vision provides a powerful feature called a “Collection” which makes it easy to group
visualization objects and apply them to a set of AF Elements derived from the same AF
Template. In this step, we will be creating a PI vision collection to show the backfilled results for
all 60 transformers in our network.

a. Open PI Vision using the “Ex. 2 Build Display” shortcut on the desktop. This will open a
new display.

© New Display D

PISCHOOLstudent01 9

O Pl Vision
(V] Assets
W BEEB I =0 K @

iz
i}

Display: Click Save fcon

I [/ & Distribution Network

W & Dryers
¥ & PISRVO1
v & uc2017

Browse or search for data in the Assets pane Q
2. Choose a symbol type like (M [Z]

3. Drag an Asset or Attribute from the Assets pane to the display
Attributes

b. Inthe Asset pane on the left, select the Distribution Network AF model and navigate
the model’s hierarchy by selecting the arrow icon, Drilldown the tree using the
following path, Distribution Network \ Alajuela \ Avenida Central \ Transformer 1\
Colegio Cientifico \ X Phase.

O I5I \)ision
@  Assets

©) Pl vision
@ Assets

O P vision
@ Assets

vy B B B % B E H w B B B

@
i}

Search in Pl System

[+ & AFExampleRUL

[vi & Distribution Netwerk

] & Dryers

[/} ¥ PISRVO1
[+ & uc2017

i

)

Search in Distribution Network

< Home
Distribution Network

(D Alajuela

®

i

Search in Alajuela

< Home
< Distribution Network

) Avenida Central
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O P"I Vision
@ Assets

O P Vision O P Vision
@ Assets @ Assets

M = B § ,.OSE@ v HE B

B
& i

Search in Transformer 1

il

Search in Colegio Cientifico

Search in Avenida Central
< Home *
£ Home & Avenida Central

< Distribution Network

< Home

< Alajuela

) Weather Conditions

@ Transformer 1 @ Colegio Cientifico @ X Phase >
m T P‘M rd
€ Z Phase >

c. Select the transformer element PT_XYZ_0343. From the attributes list below, select and
drag the Wh Delivered Load attribute on to the display canvas. This will add a trend of
the transformer loading on the display. You won’t see data until we reset the display time
range to match our dataset, 6/15/17 to 8/31/17.

O FI.\n;ision @ New Display | D

@  Assets Display: Click Save fcon* Assel | PT_XYZ0343 ¥ + Ad Hoc

w B2 E B | = : ¥ B R @m
m®
i

Search in X Phase

< Home
€ Transformer 1

@ PT_XYZ0343

N e 2019 10 5755 PM

@ PT_XYZ0380

2 PT_XYZ0381
@ PT_XvZ0387

Attributes

= Voltage Average

[= Veltage Maximum
[= Voltage Minimum

[= Voltage Quality

[= Wh Delivered Load

= Wh Delivered Load - 14d
[= Wh Delivered Load - 7d
Ex. 2 Load Prediction

[= Coefiicient_0

[= Coefficient_1 11772019 10:57.55 PM
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d. Edit the start and end times at the bottom of the PI Vision display to be 6/15/17 and
8/31/17.

O Pl Vision @ NewDisplay | D | PiscHoousmdentot | @

©  Assets Display: Click Save jcon®  Assel | PT_XYZ0343 ¥ « Ad Hoc Display m m|v

- 2 B 3 X B RO

i

2]
B

el 12,500,
10000

7,500
5,000
@ PT_XYZ0343

(@ BT_X¥Z0379 : ETE n 312017 120000 AW
& PT_XYZ0380

@ PT_XYZ0381
@ PT_XYZ0387

Aftributes

[& Voltage Maximum
(= Voltage Minimum
(= Voltage Quality

[= Wh Delivered Load
[=] Wh Delivered Load -
[= Wh Delivered Load -
Ex. 2 Load Prediction
[= Coefficient 0

[ Coefficient_1 ‘ 6/15/2017 12:00.00 AM 8/31/2017 12:00:00 AM

e. Scroll down the attributes list and find the attribute Model Predicted Load. Select and
drag this attribute onto the display canvas and drop it on the trend object. You should
see both traces on the trend.

O Pl Vision @ New Display | D | PiscHoousudentr | @

@ Assets Display: Click Save jcon* Assel  PT_XYZ0343 V «+ Ad Hoc Display m m |v

0 X BR O cOly| T &

@ PT_XYZ0379 __gctarzo}i 120000 AN ; ETE n 812017 1200:00 AM
@ PT_XYZ0380

@ PT_XYZ0381
@ PT_XYZ0387

Attributes

Ex. 2 Load Prediction
[= Coefficient_0

[ Coefficient_1

[ Coefficient 2

=] Coefficient_3

[= Model Forecast Load
8/31/2017 12:00:00 AM

Net X 6/15/2017 12:00:.00 AM
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f. Atthe top of the Asset pane, change the default display object type from a Trend to a
Value.

O P Vision

o

w H 8 B
7

g. Scroll up the attributes list and find the attribute Asset ID. Select and drag this attribute
onto the display canvas above the trend. The transformer’s asset name should appear
along with the attribute name and timestamp. (You may need to rearrange the trend and
value objects to get them to look like the display below.)

O i vision © newospay | 1] | psc

@  Assets Display: Click Save con* Assel |PT_XYZ0343 ¥ + Ad Hoc Display

0 X B R @

a
PT_XYZ0343

@ PT_XYZ0379
@ PT_XYZ0330
@ PT_XYZ0381
& PT_XYZ0387

61512017 12.00:00 Al T4 8312017120000 AM

Attributes

= Rated KVA

Derived Measurements
= Voltage Average
£ Voltage Maximum

E= Voltage Minimum 6/15/2017 12:00:00 AM | Z 8/31/2017 12:00:00 AM

— i L L

=204 L L il i =
6/15/2017 12:00:00 AM 77d 8/31/2017 12:00:00 AM

i. Inthe Format Value pane at right, expand the Visibility section and uncheck the
Label, Units and Timestamp items. In the Style section, change the Font Size to 18
and the Value color to yellow.
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11} ISCHOOL studentd 1

Display Click Save jcon*  Asset  PT_XYZ0343 ¥ « Ad Hoc Display m M v

) X B Rao ov rovy T @ Format Value v
PT_XYZ0343

Font Sze

Vaie

@ PT_XYZ0343
@ PT_XYZ0379
@ PT_XYZ0380
@ PT_XYZ0381
@ PT_Xvz0387

Format

Text Alignment

v vvwvw

Aftributes
PT_XYZ0343
Asset Specifications.
Asset ID

[= Loading

Units

| Timestamp

v Value

= Maamum KVA

[ Rated KVA
Derived Measurements.

i Voltage Average

[ Voltage Maximum

= Voltage Minimum v

j. Select he value object, right-click on it and choose Format Trend.

PT_XYZ0343

u

Format Trend...
Add Navigation Link...

2000 . .
(/152017 120000 AM  77d 8312017 12:0000 LSRR e oI

Switch Symbolto  »

k. Inthe Format Trend pane at right, in the Trace Options section, move the Model
Predicted Load attribute up to the first trace in the trend.

O Pivision

D Assets Depny € Asset | PT_xyZoM3 ¥

-~ I8 BRE By vovT@E

Foregions (]
[ |
Fomat  Dsbase .

Singh o Mubgee Scas
Show multpe scales v
Scale ange
T_XY20079 e
Use range of plted vahion |+
6 PT_Xv20380

Invent Scaie

@ PT_XYZ0001

vvvvw

] Mammum KVA

3 Rated KVA
Denved Measuroments.

] Vitage Avorage

] Votage Maximun

= Votage Maurmam
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I.  Holding the Citrl key, multiselect the Value and Trend objects. Right-click and choose
Convert to Collection.

PT_XYZ0343

o

Group Symbols
Convert to Collection...

B L
&15.’20!7 12:00:00 AM 77d 8/3'@0” 12:00:00 AM o

m. Once the display updates, click on the PI Vision display mode icon in the upper
right-hand corner of the bowser to switch to the Monitor Operations mode.

PT_XYZ0343

@ PTXYZ0343
@ PT_XvZ0379
@ PT_XY20380

& PT_XYZ0381
@ PT_Xv20387

Aftributes.

i Voltage Average

= Voltage Maxmum

& Voltage Minumum

n. Using the display scrollbar, you will be able to see backfilled results and actual values for
each transformer. These will be grouped by the phase, or parent, level of the
Distribution Network model’s hierarchy. Using the Asset dropdown list at the top of the
display, select a different phase to different to get a different group.

O i Vision
@  Assots

)

B . PT_XYZ0343

@ PT_XYZ0343
@ PT_Xv20379
@ PT_XYZ0380

Q@ PT_XYZ0381
@ PT_Xv20387

Aftributes

[ Maximum KVA
[ Rated KVA
Denved Measurements
[ Voltage Average

= Voltage Maxmum

& Voltage Mismum

46 | Page



Exploring AF Analytics for Advanced Analysis and Prediction

0. Adjustments can be made to make the display easier to use. Here are some
suggestions;
1. Close the Asset pane by clicking on its icon. This will give you more display
space.

Assets

M E H
55

2. Change the display back to Modify Display mode, select the Collection and
stretch it out to show more assets.

=y Vision
®

O i vision
Q Display Cook

[0 we’

Ll PT_XYZ0346

3. Right-click on the collection and choose Modify Collection. This will return you
to the original group containing the original Value and Trend objects. Here you
can resize them and change their formatting.

PT_XYZ0344

Modify Collection
Format Collection...

Edit Collection Criteria...

L it ! L 1 1 L L 1 1 L
6/15/2017 12:00:00 AM 77d 8/31/2017 12:00:00 AM

Click the Exit Modify Mode icon in the upper right-hand corner of the object

boundary to return to the full display.
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Example 3 - Operationalize Forecast Models
for Multiple Transformers

Learning Objectives

Modify the predictive equation to calculate forecasted values for transformer loads
Employ Advanced scheduling feature of AF Analytics and Pl Future data tags.
Operationalize forecasting model (assume today is 8/31/17)

Asses the forecast for all 60 transformers in PI Vision Collection

Create a Forecast from the Predictive Model

a.

b.

Go to the Library view in Pl System Explorer (lower left-hand corner). Select the
Single Phase Transformer template. Click the Analysis Templates tab. Choose the
“Ex. 3 Forecast Load” analytic.

Q \\PISRVO1\Distribution Network - PI System Explorer (Administrator) L:lE-

File View Go Tools Help
@ Database [ QueryDate ~+ © @ O Back H, Checkin %) « (2] Refresh | g) New Template ~

Library |Single Phase Transformer
@ Distribution Network General | Attribute Templates | Ports | Analyss Templates | Notification Rule Templates
- @ Templates e Name: Ex. 3 - Forecast Load
=~ () Element Templates s Ex. 3 - Forecast Lo
@ Crast ©| B | Name Description:
(§ Headquarters N e =
b g eter o Cotegories
(@ Phase oo Ex3 - Forecast Load
=i () Secondary Transformer Analysis Type
& ;: S"?‘ FEt ik sonkisask @ Voltage Ranges Enable analyses when created from template
(@ Substation
%~ G Transformer Bank Example Blement:  Aljuela\Avenida Central\Transforme
@ Weather
* Event Frame Templates
g Model Templates 3 o ncv variable Evaluate
+- ~§ Transfer Templates Name Expression
@ Enumeration Sets
Reference Types
+ Tables
&) Table Connections
= (] Categories
) Analysis Categones
) Attrbute Categories
@) Element Categories
() Notification Rule Categories lse tout()
() Reference Type Categories
©) Table Categories

Search Element Templates O ~

® Expression Rollup

Event Frame Generation sac

Output Attribute

#1h"))) AND (NOT Badval
1h'))) AND (NOT Badval(
d+1h') +

9 Bements

— Event Frames

.| Library

= Unit of Measure

28 Contacts Scheduling: () Event-Triggered (@) Periodic et

% Period: 01h 00m 00s | Configure | Output time stamp override: *+ 1h
S I — | -

Single Phase Transformer Modified:1/18/2019 5:3401 AM Owner:PISCHOOL\student01

Take a closer look at the analytic equation below. First, we have added a conditional
check to ensure all forecast-based measurements are good. This reduces the chance of
posting an errant forecast value which can erode user confidence.

Secondly, we have shifted the time references forward one hour. This change requires
the terms of the modelling equation to be based on the PI Point attribute, Wh Delivered
Load using the TagVal() function in AF Analytics.
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Name Expression

/ Check

that 1nput values are all good betore ’f‘ﬁl.i’g for st.
IF  (NOT Badval(TagVal('Wh Delivered Load", '*-7d+1h"))) AND (NOT BadVal(TagVal('Wh Delivered Load', '*-14d+1h')))
AND (NOT BadVal(TagVal('Ambient Temperature®’, '*+1h'))) AND (NOT BadVal(TagVal('Relative Humidity','*+1h")))
THEN ‘Coefficient @' * TagVal('Wh Delivered Load', '*-7d+1h') + ‘'Coefficient 1" * TagVal('Wh Delivered Load', '*-14d+1h")
Forecast + ‘'Coefficient_2' * TagVal('Ambient Temperature', '*+1h') + 'Coefficient_3' * TagVal('Relative Humidity','*+1h")
+('Intercept’)

One or more bad values, do nothing.

Else Noéutput()

c. By default, AF Analytics posts results at the current time. This analytic is scheduled to
run hourly, however, as a forecast, we need to be able to post the results, one hour into
the future. Click on Advanced to access the dialog to change the result posting rime.

i W Event Frame Templates TR
- (% Model Templates Add a new veriable| Evaluate

Qutput Attribute

| & 4§ Transfer Templates Name Expression
“- @ Enumeration Sets

IF  (NOT Badval(Tagval('Wh Delivered Load', '*-7d+1h'))) AND (NOT Badval(Tagva
AND (NOT BadVal(TagVal('Ambient Temperature', '*+1h'))) AND (NOT BadVal(TagVal('
THEN ‘Coefficient_0' * TagVal('wh Delivered Load', '*-7d+1h') + 'Coefficient_1' [
Forecast | + ‘'Coefficient 2' * Tagval('Ambient Temperature', '*+1h') + 'Coefficient_3" * |Model Forecastload |
+("Intercept’)

Else NoOutput()

Scheduling: () Event-Triggered
Period: 01h 00m 00s

Advanced configurat/ WSS

d. We have specified that the output of this analytics be posted in a future data tag
one hour past the time of its calculation.

— Cutput Time Stamp

) Trigger Time

®) Relative ta Trigger Time: #21h
() Variable: | |v|

Mapped output attributes require a future Pl point to
save output history. For newly mapped output attributes
that save output history, Pl Analysis Service will create
future Pl points.

—Automatic Recalculation

[ Recalculate analysis for out-of-order input events
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e. We are now ready to test the forecasting analyses. Go to the Management view in Pl
System Explorer (icon in lower left-hand corner). Select Ex. 3 Load Forecast under
Analysis Searches. Click the checkbox at the top next to Status to select all 60
forecasting analytics. Start them by clicking Enable.

File View Go Tooks Help
@ Database M QueryDate + © @ D Back ) H, Checkin %) « 4] Refresh

Management Analyses

Choose a type 60 total analyses selected (60 on this page) 1-600F60 < |
e = ¥ Sttus © 8 Sement

v foo AajuelaiAvenida Central\Transformer 1\Colegio Clenti#ico\Z Phase\PT_XYZ0
Analyss Searches fio Aajuela\Avenida CentrafiTransformer 1\Colegio Genthicoly Phasel?T xvzd |
+* X fto Alajuela\Avenida CentrafiTransformer 1\Colegio Cient¥ico\Z Phase\PT_XY20
Al £ fo0 Alsjucla\Avenida Central\Transformer 1\Colegio CientiicolY Phase\PT_XY2!
Enabled - fo0 Majuels\Avenida Central\Transformer 1\Colegio ientico\Z m,xvzq

fi Alajuela\Avenida CentraliTransformer 1\Colegio CientficolX Phase!PT

Oluabied - f9 Alsjuela\Avenda Central\Transformer 1\Colegio Gentfico\X Phase\PT_XvZ0 &
Example 2 Prediction ks fo0  Mlajuela\Avenida Central\Transformer 1\Colegio Cientiico\Y Phase\PT_)
Example 3 Forecast ’ S Alayuela\Avenida Central\Transformer 1\Colegio Clentfico\X Phase\PT_)

fo0 Alajuels\Avenida CentrafTransformer 1\Colegio Cientfico\X Phase\PT )
S0 Alajuela\Avenida CentraliTransformer 1\Colegio Gentico\X Phase\PT.
i Majuela\Avenida CentrallTransformer 1\Colegio ClentFico\X Phase!PT
o9 Alajuela\Avenida Central\Transformer 1\Colegio entifico\Z Phase\PT_XY20
9 Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XY20
f9 Alajuela\Avenida CentrallTransformer 1\Colegio Cientfico\Z Phase\PT_XYZ0
89 Alajuela\Avenida Central\Transformer 1\Colegio Clentifico\X Phase\PT_XYZ0
foo Alajuela\Avenida CentralTransformer 1\Colegio Centifico\X Phase\PT_XYZ0
0 Alajuela\Avenida CentrallTransformer 1\Colegio Gentfico\2 PhaselPT_XYZ0
foo Alajuela\Avenida Centraf\Transformer 1\Colegio Clentifico\X Phase\PT_XYZ0
fo0 Majuels\Avenida Central\Transformer 1\Colegio Cientico\Y Phase\PT_XYZ0
fio Alajuela\Avenida Centrall Transformer 1\Colegio Gentfico\X Phase\PT_XYZ0
fi0 Alajuela\Avenida Central\Transformer 1\Colegio Cientiico\X Phase\PT_XY20
fi9 Alajuels\Avenida CentralTransformer 1\Colegio Clentifico\X Phase\PT_XY20
fo0 Aajuela\Avenda Central| Transformer 1\Colegio Cientiico\Y Phase\PT_XYZQ
foo Alajuela\Avenida Central\Transformer 1\Colegio Clentfico\Z Phase\PT_XYZ0
S0 Alajuela\Avenida Centraf\Transformer 1\Coleglo Cientfico\Z Phase\PT_XYZ0
foo Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XY20 +
- >

KNUNRRERNURURKRRURRRS R RK RS
0000000000699 000060006005660606

f. Once you get green icons indicating all the analytics have been started, Backfill, or in
this case “Forewardfill”, the analysis from 8/31/17 to 9/10/17. (Remember, today is
8/31/17 and we have weather forecast data through the end of September 2017.)

File View Go Tools Help
@ Database ! QueryDate ~+ © @ D Back ) ©, Checkin %) v (2] Refresh

Management Analyses

Choose a type 60 total analyses selected (60 on this page) 1-600f60 < | >

. Analyses i S © & Eement Enable | Disable selected analyses
L foo Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XY20 ~ Enable | Disable automatic recaiculation for selected
- Analysi Searches foo Alasjuela\Avenida Central\Transformer 1\Colegio Gientifico\Y Phase\PT_) ——————

+ X fto Alajuela\venida CentraTransformer 1\Colegio ientifico\Z Phase|PT_XY2 Backfi/Recalculate selected analyses

All fto Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Y Phase\PT_) start [8/31/17

abled foo Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_) e [T

N 999

fio Alajuela\Avenida Central\Transformer 1\Colegio Gientifico\X Phase|PT_
fe Alajusla\Avenida Central\Transformer 1\Colegio Cientifico\X Phase\PT )
foo Alajuela\Avenida Central\Transformer 1\Colegio Gientifico\Y Phase\PT )
foo Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\X Phase\PT
fto Alajuela\Avenida Central|Transformer 1\Colegio Gientifico\X Phase\PT )

What should we do with existing data?

() Leave existing data and fill in gaps

(@ Permanently delete existing data and recalculate
[] Recalculate dependent analyses

¥ @
¥ 9
¥ @
¥ @
¥ 9
9
9
v 9
9
v 9
v @ feo Alajuela\Avenida Central\Transformer 1\Colegio Gientifico\X Phase\PT_ |I
¥ 9 foo Alajuela\Avenida Central\Transformer 1\Colegio Gientifico\X Phase\PT_)
(/] fo9 Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XYZ0 = -
% 9 x Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XYZ0 Pending Operations
) Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XYZ0
¥ @ o Asiuela\ivenda CentralTransformer 1\Colegio Genticolx PhaselpT X120 | nobieg 60 e iy eiin A Dismiss]
9 foo Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\X Phase\PT_XYZ0 Queved by:  PISCHOOL \student01
v 9 fto  Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XYZ0 ) Complete
v 9 fo Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\X Phase\PT_XYZ0
¥ 9 fir Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Y Phase\PT_XYZ0 Recalculating 60 analyses Dismiss|
¥ 9 f9 Alajuela\Avenida Central\Transformer 1\Colegio Gentifico\X Phase\PT_XYZ0 T.'.',":..a"“’"“m : ;llw m .:.
¥ 9 f9 Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\X Phase\PT_Xv20 S
v 9 foo Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\X Phase\PT_XYZ0
¥ @ ft9 Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Y Phase\PT_XYZ0
(/] feo  Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XYZ0
¥ 9 o Alajuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XYZ0
=V & fto Alsjuela\Avenida Central\Transformer 1\Colegio Cientifico\Z Phase\PT_XY20 v
o<l " >
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g. Once the backfill is complete, Disable the analyses. Return to the desktop and open PI
Vision using the desktop shortcut named “Ex. 3 Forecast Evaluation”.

O Ppivision © Mow Dispay

7] Ex.3 Forecasting Model Evaluafion ~ Asset | X Phase ¥

PT_XYZ0343 PT_XYZ0379

GHMS2017 120000 AM 870 G/102017 120000 AM s A 74 9102017 120000 AM 9102017 120000 AM

PT_XYZ0381

61572017 12:00:00 AM 8 0 A 6152017 12:00:00 AM 8 9/102017 12:0000 AM 6152017 12:00-00 AM a7 91072017 12:00%0 AM

PT_XYZ0389 PT_XYZ0390 PT_XYZ0393

ey

152017 120000AM  67d  S/10/2017 120000 AM /1572017 12.00.00 20 9102017 12,0000 AM /152017 12.00.00 AM

" todibh b
9102017 12.0000 AM

- 31

h. The dashed yellow lines have been drawn over the trends to show “today”, 8/31/17. The
forecasted values we have just generated are shown to the right of this line as future
data. Let’s see how the Model Forecast Loads are affected by the cooler ambient
temperatures forecasted for September.

Right-click on any trend in the PI Vision Collection and select Modify Collection.

PT_XYZ0379

:

Modify Collection
Format Collection...

! yon Edit Collection Criteria...
6/15/2017 12:00:00 AM 9/10/2017 12:00:00 AM
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i. Expand the “Assets” pane by clicking E in the upper left-hand corner of the PI
Vision portal. In the Search dialog type the name of base element used to configure the
P1 Vision collection, PT_XYZ0343. Scroll down the Attributes list and find Ambient
Temperature.

O Pivision
@ Assets

vy B

4 PT_XY20343 Python Forecast Load
& PT_XYZ0341 Python Predicied Load
o PT_XY20343 Voltage Average

4 PT_XYZ0343 Vollage Maximum

# PT_XVZ0341 Vollage Minimum

o PT_XV20341 Voltage Quality

& PT_XYZ0343 Wh Delivered Load

Aliributes

[= Intercept

[ Model Predicted Load
Ex. 3 Load Forecasting
[ Model Forecast Load
Network

= Pnase

[ Substation

[ Wind Speed BNS/2017 12:0000 AM

j. Select and drag the Ambient Temperature attribute onto the trend object in the
collection. This will add the temperature forecast data, both historical and future, to the
trend.

O Pl Vision
@ Assets

'3

@ PTXYZ0343
# PT_XYZ0343 Python Forecast Load
& PT_XY20343 Python Predicted Load
& PT_XYZ0343 Voltage Average
& PT_XYZ0343 Voltage Maximum

# PT_XYZ0343 Voltage Minimum

& PT_XYZ0343 Voltage Gualty
@ PT_XYZ0343 Wh Delivered Load

Aftributes

{2 Intercept

[= Model Predicted Load
Ex. 3 Load Forecasting
= Model Forecast Load
Network

[= Phase

= Substation

Weather Condtions

[ Ambient Temperature
[= Relative Humidgity

[= Wind Speed
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Return PI Vision to “Motoring Operations” mode by clicking @ in the upper fight-
hand corner of the PI Vision portal.

O piVvision © New Diolay

@  Assets casting Model Evaluation *  Asset

w5 2 2B | =0 kB

# PT_XYZ0343 Python Forecast Load
@ FT_XYZ0343 Python Predicted Load
@ PT_XYZ0343 Voltage Average.

@ PT_XYZ0343 Voltage Maxmum

@ PT_XYZ20343 Voltage Minimum

& PT_XY20343 Voltage Quality

@ PT_XYZ0343.¥h Deivered Load
Attributes

= Intercept

[ Model Predicted Load

Ex. 3 Load Foracasting

[ Model Forecast Load
Network

[= Phase

[ Substation

‘Weather Conditions

[ Ambient Temparature
[ Retative Humidity

[= Wind Speed

Collapse the “Assets” pane to give you a better look. You can double-click on any
individual trend for a more detailed examination of how things look.
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Appendix A - Python Access to Pl using Pl
OLEDB Enterprise

Create a Pl View — PI OLEDB Enterprise

PI Data can be imported directly into Python through a view configured in Pl OLEDB
Enterprise. Views are configured in PI SQL Commander Lite. Here are the steps to create a
view containing the data used in the lab example.

a. Open Pl SQL Commander Lite from the Windows taskbar, (‘

b. Under the Pl OLEDB Enterprise branch of the Object Explorer hierarchy, select the
PISRVO01, right-click and Connect. Click OKk.

@ PI SQL Commander Lite |=|B] x
File Edit View Tools Help

2 NewQuery | ! Bxecute @ |§ 1) | € Query Compendium

Object Explorer v x
% =
4 (J)OLEDB Data Sources
4 (@¥PI OLEDB Enterprise
J PISRVOT (connecting..)
4 (@ P OLEDB Provider

Al PI OLEDB Enterprise Login | = |2
4 [ PPISQL Clent
J PISRVOT\Distribution Network Sever.  [PISRVD! | 0K

5/ 0DBC Deta Seurces

[V Use Windows NT Integrated security Cancel
User D
Password Options >> |

c. Expand the Distribution Network catalog in Object Explorer hierarchy. Expand the
Data T folder. Then right-click on the Data T folder and slide through the menu to select
Dynamic Transpose Function (Asset).
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File Edit View Tools Help

2 NewQuery P Execute @ |43 5% 43| @ Query Compendium
‘Object Explorer - X
Bles =N 2
4 LjClEDBIhhSmm L]
4 aF\ULEDBEMEDﬁH
4 (BFSAVDT
4 [Catalogs
b [ AFEamoeRUL
b | Configuration
4 | Distribuson Netwerk
b [(Asset
> [Data

New Transpose Function L Dynamic Transpose Function (Asset)..

|Emu1C|dnm Database Obiects... Dunamic Ty
Create a transpose function with all the attributes of an element template.
The transpose function will update automatically when attributes are added, removed, or renamed.
»  [EventFrame 2
| System
p [ ucaor?
4 (@FI OLEDB Provider
u PISRVO1
4 (P SGL Chent

Functinn [Fuent Framel

d. Inthe Transpose Function Wizard dialog choose Transpose Interpolate Range. Click
Next.

@ OSl=oft.

Transpese Function ¢ yranspase function:
Element Template Transpase Snapshot

Definition Transpase Interpalate Discrete

Options [ranspase 1
Summary Transpase Archive

Exccution Versianed Transpose Snapshot

Versianed Transpose Interpolate Discrete
Versianed Transpose Interpolate Range
Versianed Transpose Archive

=

e. Choose Single Phase Transformer. Click Next.

@ 0Sl:oit.
Trenspaze Function Select Element Template:
Element Template reatt
Lo Headquarters
Options HMM Single Phase Hourly
Summary Meter
Execution Phase
Secondary Transformer
[Single Phase Transformer.
Single Transformer
Substation
Transicemer Bank
Weather
[_<eaf]
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f. Change the function name to “My TransposelnterpolateRange_Single

Phase Transformer”. Click Next.

(@ s
Transpose Function Transpose function name:
Element Template I :_Single Phase
Definition Select Attribute Path:
Options \
Sumemary
Execution
[ Include subtree
[Fe==r]

g. Click Next.

@. OSl:oft.

Transpose Function Lz

Element Template: [ Values as VARIANT
Definition [/ Create function table
Options

Summary

Execution

h. Click Next.

@@ osii.

Tansposefuncion g

Element Template —Transpose function: TransposelnterpalateRange

Definition --Element template: Single Phase Transformer

oo Transp i My Range_Single Phase
G ~Values as VARIANT: No

Summary ~Create function table:  Yes

Exzeution

CREATE FUNCTION [Distribution Network] [DataT} [My
AS

. Single Phase
[Distribution Network]. [TransposeinterpolateRange] <N Single Phase Transformer’, N'V', False include attribute sul

CREATE TABLE [Distribution Network] [DataT) fft_My

Single Phase ]

AS
[Distribution Network] [DataT] My

- Single Phase
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i. Click Execute.

@. OSl:oit.

Transpase Function

Progress:
Element Template
Defnition .
o Details
” Element Template Function Table
e TransposelnterpolateRa
ransposelnterpolateRange.
Execution e 2

Single Phase Transformer

j.  Click Done.

Transpase Function

@. OSl:oit.

Exccution completed succesfully
Element Templote
Definition
s Details:
EHlement Template Function Table

Summary T nterpoloteRa

Tanspeseln n
Expouti 3 9

Single Phase Transfarmer -] @

k. Expand the Table-Valued Functions folder to see you newly created function. Right-
click on My TransposelnterpolateRange_Single Phase Transformer and Execute

Predefined Query...

Fle Edt Vew Quy Tooks Help
2 NewQuery | Esecne @ D[EHD) 04 Query Compendiom . .
[Coject Explorer < x| [ Guryiag - Peavor x s
Desen SELECT oh Path + wh Name Elemant, ti -
Ao [Distribution Netuork] [Asset] [ElesentTesplate] et I
4. QEELE N Sowons Iwes J0t% [Distribution Network). [Asset]. [Elesent] e
4 QPIOLEDD Evtpree D - o.ElenentTemplateld
o (PSR [Distribution Network) [Asset]. [Elementricrarchy] eh
P eh ElementiD
el #LY [Ohstribution Metwork] DataT [Hy _single Phase 1|
) FEangeil =
h ElementIn
TE(N*-1 r5tartTinet/
o ([ Tt ek oRTE(N' I*EndTime®
e (R /*TimeStep*/
40w ) s
o WNERE et Mame - N'Single Phate Trensformer’
- S OPYION (FORCE OROER, IGMORE ERRORS, ENBED ERRORS -
@ 2 e [T
Fants | 1y Vessagen
v ] -
o 1 Xz :mammm T om\u!’ oxn;'l
» rarspcosreerpcisefany. 5 3 .y
(e inia hose sl 2 < OEIG 010525 OLZAN0 11N QIR | 02417
& ' B 3 < 2 PaswPTOCIIG B985 133120000 21131 0108 | 024)
} aFurcon Tatles X |orop s 20 200328 123123000 HINES RN | Wi
aEwane 5 JZN) | 060325 T30123000 163 0% | Wi
ei® e 6 UMY M08 IIZ00 MINE E | WM
v Creste Furnction Table 7 Prasel FTOZIME | BB 2INN00 MU BMSQ | 6@
{J Sytom ol B | Vapainivancs Corwal Transkomer TColnge Cartco'Y Pase FTXYZI0M 2080926 013000 J416) TSasa2 | o0
(§ ue2or ] 3 | VAl Cortral Trasbormes T Coego CarsicoY Pane PT X204 21B0528 D200 361363 764682 | 60200
P OLED Proder 10 | \Aapal v Coriol Tramatomee TCobmpeo CoriY Phane T XYZ00M8 200640826 123120000 182100 S0 | 287
- " PrasePTXY206 20160525 3013000 MEAT | R8T | 2673
L ” PraselPTYZIMS  XBBHHID0 MDD BE01 | 27
4 QPSR Chee 13 | \Alapoeisivancs Cermal Trasmioemes IColeps ClenficolY Phase PT_YZOME 20130825 121123000 2610908 NO781 | 46600
() PISRVORatnsion Nessark 14 | Aapeia\ivenca Certral Transkoemes TColepo CentficnY Phase PTXYZIME 20100925 130123000 2610908 47753 | 44600
/008 Cua Saen sl ProselPT X206 2S94 1IN N00 X808 18T |4k
< - >
T — | PEAVOL | P1OLEDR Loserprise | COI0G5437 | 140 cows
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I. Select the entire predefined query shown in the query viewer and copy it into the

clipboard.

[SELECT eh.Path + eh.Name Element, tir.%
IFROM [Distribution Network Lab].[Asset].[ElementTemplate] et
INNER JOIN [Distribution Network Lab].[Asset].[Element]

ON et.ID = e.ElementTemplatelD

INNER JOIN [Distribution Network Lab].[Asset].[ElementHierarchy] e

ON e.ID = eh.Elementl

eh.ElementID,
DATE(N'*-1h'),
DATE(N'*"),

/*StartTime*
/*EndTime*/
/*TimeStep*/

= N'Single Phase Transformer'

IGNORE ERRORS

m. Under the Asset folder, find the Views folder. Right-click on Views select Create View.

ROSS APPLY [Distribution Network Lab].DataT.[My TransposelnterpolateRange Single Phase Transformer]

File Edt View Query Tooks Help
D Newauery | B Esecute @ EAGE]E) | Query Compensium

Cbgect Explorer
e ] ]
4 (JIOLEDE Data Sources
4 {31 OLEDS Enterprise
« [gPsavm
4 [Catalogs
v [ AFExamcieRUL

8 Queny T3l - PISAVOT X

L4 [J Distribution Network
a4 [afesst
b [ Tables
4 e

3 Creste View...
b [ Table! Export Custom Database Objects.. ]
b Cafmesd o o
© [aData

4 [@DstaT
[ Tables
[Viens
4 [ Table-Vahed Funcions
1+ [y TransposelnterpolateRange_Single Phase Transformer
I [flTranspossimempoisieRiangs_Single Phase Transiomer

¥
SELECT eh.Path + eh.Name Element, tir.* -
|| FROM [Distribution Metwork].[Asset].[ElementTemplate] et
| | TwmeR 01n [Disteibutien Metwark).[asset].[Element] &
Ot et.10 - ¢.ElementTemplateld
TumER 01N [Disteibutien Metwark].[Asset].[ElementHizrarehy] eh
on
CROSS APPLY [Distribution Network].DataT.[My _Single Phase 1
( =
: eh.EL 10,
DATE(N'®-1h'), /*StartTime®/
DATE(N'*"), J*EndTimes/
Er [ TineStep®/
) wir
WHERE ct.Mame = N'Single Phase Transformer®
OPTION (FORCE ORDER, IGNORE ERRORS, EMBED ERRORS) -
[0 Results | 13 Messages
N Blement Time Intercept  Coefficiert 3 Coefic ~
i i Fhase FT_XY20342 | 20150825 23123000 | 21 13116 | 021081 | 024178
2 | Visposisiverica Central Transhormes 1Colegeo Cienshcol? Phsss PT_X20342 | 20180825 130123000 2113118 | 0120081 02817
3 TiColege Cier 020342 | 20180925 133123000 2113118 | 0120081 02817
4 | VibueialAverics Cenmal Transfcrmer 1\Colegio Ciersfico X PhaselPT_XYZ0M3 | 20180325 123123000 -1831169 | 08176 35184
5 | \WapuelalAverida Cenmafi Transfcmer 11 Colegio ClenthcoX PhaselPT_XYZ043 | 2016-09:25 1301:23.000 -1831169 | 09276 35184
& | Viapuelaiverida Cenraf Transformer 1Colegio CientficolX PhaselPT_JZ0M3 | 20160925 133123000 1831169 | 2092276 35184
7 | Viepuelaidverida CertraliTransformes 11Colegio Cienshcol PhaselPT_XYZU344 | 20160926 123123000 3551353 | 7546542 60200
B | Vispueisiveruca Contal Transfermes 11 Celeges CierthoolY PhoselPT 7042 | 20180925 130123000 3561353 | 7546642 60200
9 | Viapoela\verica CentrafiTransformes 1/Colegie Cientfco! PhaselPT 20044 | 20160325 133123000 3551353 | 7546502 6200
n 2 T\Colegio CiersiicolY PhaselPT XYZUMS | 20180925 123123000 1462333 | 2557701 24573
1 | Vaetaiéverida CentrafiTransformes 1 Cclegio CienthicolY Phasel T XYZUMS | 201809:25 130123000 1482333 | 2587701 24579
12 | e - FhaselPT_XYZ0345 | 20180825 133123000 1482333 | 2887701 24679
13 | Vet dverida CanaliTransfeemas 1 Celegio Cienthes!Y PhasslPT XYZ0346 | 0180825 123123000 2638908 | 3147783 agkid
L[ [|| 14 | titspomtsiverac CentranTransfcrmes 11Colegro CiensicolY PhasePT_XYZ0346 | 20160325 130122000 -26399.06 | 147753 46600
15 | sttt ot Tomstonme 1€ deon CrshsY e T 0TS GBI 00 2539808 334758 600~
< w >
|| | @ Query executed successiuily PISRVO1 | P1OLEDE Enterprise | 000005437 | 180 rows

n. The following query should now appear in the query window.

CREATE VIEW [Distribution Network].[Asset].[<view nameX]

AL
ulew definitinnﬂ
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0. Replace <view definition> with the query saved in the clipboard

CREATE VIEW [Distribution Network].[Asset].[<view name>]
AS

SELECT eh.Path + eh.Name Element, tir.

FROM [Distribution Network].[Asset].[ElementTemplate] et

INNER JOIN [Distribution Network].[Asset].[Element] e
ON et.ID = e.ElementTemplateID
INNER JOIN [Distribution Network].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID
CROSS APPLY [Distribution Network].DataT.[My TransposeInterpolateRange_Single Phase Transformer]

eh.ElementID,

DATE(N'*-1h'), /*StartTime*/

DATE(N'*'), /*EndTime*/

N'3em' /*TimeStep*/
) tir

WHERE et.Name = N'Single Phase Transformer'
OPTION (FORCE ORDER, IGNORE ERRORS, EMBED ERRORS)

p. Modify this query by;
a. Replacing, within the brackets, “<view name>" with “My Pole
Transformer Loads”.
b. Replace the SELECT statement by cut-and-pasting the following text:

eh.Name, tir. Time Timestamp, tir.Loading, tir.[Maximum KVA], tir.[Rated KVA],
tir.JWh Delivered Load], tir.[Wh Delivered Load - 7d], tir.JWh Delivered Load -
14d], tir.JAmbient Temperature], tir.[Relative Humidity], tir.[Wind Speed]

c. Change the Start Time from ‘y’ to “15-jun-2017".
d. Change the End Time from ‘' to '31-aug-2017".
e. Change the Time Step from ‘30m’ to ‘1h.

g. When finished with the edits, the query should look like the one below.

CREATE VIEW [Distribution Network].[Asset].[My Pole Transformer Loads]

AS

SELECT eh.Name, tir.Time Timestamp, tir.Loading, tir.[Maximum KVA], tir.[Rated KVA],
tir.[Wh Delivered Load], tir.[Wh Delivered Load - 7d], tir.[Wh Delivered Load - 114d],
tir.[Ambient Temperature], tir.[Relative Humidity], tir.[Wind Speed]

FROM [Distribution Network].[Asset].[ElementTemplate] et

INNER JOIN [Distribution Network].[Asset].[Element] e
ON et.ID = e.ElementTemplateID
INNER JOIN [Distribution Network].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID
CROSS APPLY [Distribution Network].DataT.[My TransposeInterpolateRange_Single Phase Transformer]

eh.ElementID,

DATE(N'@6/15/17"'), /*StartTime*/
DATE(N'@8/31/17"), /*EndTime*/
N'1h' /*TimeStep*/

) tir

WHERE et.Name = N'Single Phase Transformer'
OPTION (FORCE ORDER, IGNORE ERRORS, EMBED ERRORS)

r. Either right-click on the query and select Execute or click on the Execute button on the
top menu bar to run this query and to create the view. You should wee the following
message in the Results grid and a green light in the bottom message bar of Pl SQL
Commander Lite.
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|3 Messages

Command completed successfully

@ Query executed successfully

s. Return to the Views folder in the Object Explorer hierarchy. You may need to right-click
on the view folder and Refresh it to see your new view. Right-click on the view, My
Pole Transformer Loads, and Execute Predefined Query...

Fle Edit View Query Tooks Help
2 Newuery | B Becute @ A& | 8 Query Compendium
[Object Explorer = % | [[5) Querydsg -PERVD! | 5y Quenylaal-PISRVOT X =
Bl e ] ] SELECT Top 100 * -
4 (IOLED8 Dotn S “a||| #RoM [Distribution Network).[Asset].[My Pole Transformer Loads]|
4 @PICLEDS Enterprise
+ [BFsR
4 [ACatalogs
» [ AFEampleRUL
4 | Dssibusion Nebwork:
4 [heset
b CaTables
4 (Ve
) [3]My Pole Transiomer Loads -
3] Pole Transiormer Loads
[ ol [EEY ET=—]
b D Fsstion Tabks Name Tresiang Losdrg  MammumKVA  Fsted KVA _WhOekvered Losd  Wh Defvered Losd -7 Wh Defim
—— 1 [FIo0Z0M2 | 0170615 00000000 365 | 01 70 ] ) %
- 2 [FTXYZI42 | 20170675010000000 365 01 10 5 m m
4 [DaT 3 | PTXYZ0342 2017.08-15020000.000 384 (5] 10 £ fl n
(3 Tables & [FTXZI3Q 20170615030000000 384 01 10 £ 3 £l
Ve 5 | PTXYZ0342 20170615 040000000 O ai 10 0 ] 7
. 6 [FTOZI4 2017-0615050000000 O (5] 0 0 ] []
a T Valued Functions
et 7 [PTZma 20170615060000000 0 [ 0 0 [ [
[ Trampomsiricmoleiefiangs_Sengk Froec Tramslormer 8 | PT0ZI42 | 20170615 070000000 0 01 10 [] ] 0
[EJTranspeseinierpolsteRange,_Single Phase Tramsiormer 9 |FLZ04 2017-067150800.00000 0 (5] ] 0 ] [
b [ Funcion Tables 10| PT_XvZ0342 2017.0645030000000 O (5] 10 0 [] []
— 1 | PTXYZ042 | 2017.06-15 100000000 O [i5] 10 0 0 []
K 12 | PTXYZI4Z | 20170575 10000000 O K] 10 [] ] []
* e 13| FTXv0342 | 20170615 120000000 0 (K] 10 [] ] []
b+ |§ System a n
» e L
4 d@P| OLEDS Pravider v || | @ Query executed successhully PISRVO1 | Pl OLEDS Enierprise | 00.00:30489 | 100 raws

t. Edit the query by deleting the “TOP 100” specification in the SELECT statement.
Either right-click on the query and select Execute or click on the Execute button on
the top menu bar to rerun the query. This time you should get all 110,940 rows.

e £t
J bew P bccte @ E]E) | @ Query Compeniom
ool . =] [ Qo o[ 5 Qe SR v
R ] SELECT - £y
+ (FOLEDS Dot Sosemn [~ || #Ro# (otstribution Netuork].[Asset] . [y Pole Tramstormer Losds]
4 @PIOLEDE Erterprise
Brsaver
£ Camogs
) AFExampieRUL
\J Coniguration
4 | Distrbustion Network.
P
3 Tabbes
4 CaViews
I 1My Pole Transiormer Losds v
1) Pole Trarsformer Losds. .
[ . (| D] Resus | 3 Messages
(2§ Funcace Taties ] Timesare Loadrg Fated KVA T4 b Dok |
o 1 [PT0008 | 01706 1500000000 365 01 0 % 370 =)
' 2 | PT0Z0M2 20170615010000000 368 (1] 0 %5 m 0
(aDesT 3 | PTXZ0MZ 201706-15 020000000 364 (1] 0 364 n m
(2 Tables 4 |POTOMI 017061500000000 364 01 0 b 346 m
CaViews s |Fozmaz 0mes150400m00 0 o " [ o 7
6 |PTooq0Mz 20170615050000000 0 o1 0 [ a ]
Tatke-Vahiod Funcions
« ERTh 7 | P00z | 20174615 06.0000000 0 (1] 0 ] ] [}
I [f&]Mr TransocesirterpoiateRange_Single Phase Transiormer 8 | PT_0Z0MZ  201706-15070000000 O (1] 0 [] (] °
b [ Trnspossirterpolatefiange_Singie Phase Transtomer 9 |PT_XZ0M2 20170615 080000000 O (1] 0 [] [] °
i Funceon Tabies 10 | FT_XYZ0342  2017-06-1508:0000000 0 o 0 [] [] []
} Cawenfrane 11 | PTX20342 | 20170615 100000000 0 (1] 0 [ o o
! I 12 | PT_X20342 | 20170615 110000000 0 oi 10 [ o )
| 13 | PT 020342 | 20170615 120000000 0 o L] [] ] []
TE +» [ STnomn o sss00men o ns e a a B
-
1 ucaers L ——
4 P OLEDE Provder || @ Query esecuted successiully | PISRVO1 | POLEDS Enterpeise | 000032423 | 110040 rows
——
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Develop the Model in Python

The following code provides the same analysis as Example 2 except it accesses Pl data using a
P1 OLEDB view. The Python “adodbapi” package is used to manage the connection.

To run the code with your Pl OLEDB View, you’ll want to replace “Pole
Transformer Loads” with “My Pole Transformer Loads” in the first cell

) of this Jupyter Notebook.
Tip

a. Open Jupyter Notebooks from the windows Taskbar, 5. Open the Python script,
Load Prediction - Example 2 (Pl OLEDB Enterprise).

b. In the first cell, change the select statement to 'SELECT * FROM [Distribution
Network].[Asset].[My Pole Transformer Loads]'. This will cause Python to access
your Pl OLEDB Client view and create the dataframe, poleTransformerLoads. Select
this cell and hit Shift+Enter. Wait until you see the table preview before moving to the
next cell.

# Import Python packages.
import adodbapi as ado

import pandas as pd #
from sklearn.linear model import LinearRegression # Li

# Connect to "Distribution Network Lab™ model in AF through the PI COLEDB Enterprise
PI_connection = ado.connect ("Provider=PIOLEDBEnt; Integrated Security=SSFI; Data Source=PISRV0]l;Command Timeout= ]
# Create a cursor object to access the data serer for the "Distribution Netweork Lab™ database in AF.
13 PI_cursor = PI_connection.cursor()
# Select the entire table using the viev configur in PI SQL Commande

istribution Network]. [Asset].[My Pole Transformer Loads=]')

PI_cursor.execute ('SELECT * FROM [

# Extract first row, index=0, to get column names for use as dataframe headers
columnNames [ x[0] for x in PI_curscr.description]

print ("PI View column Names:\n\n", columnNames})

# Unpack the cursor rovs into a dat en

poleTransformerLoads = pd.DataFrame ([dict{zip(columnNames, row)) for row im PI_cursor], columns=columnNames)

# Take a look to see if everythking wvorked.

poleTransformerLoads.head()

PI View column Names:

['Name', 'Timestamp', 'Loading', 'Maximum KVA', 'Rated KVA', 'Wh Delivered Lecad', 'Wh Delivered Load - 7d', 'Wh Deli

vered Load - 14d', 'Ambient Temperature', 'Relative Humidity', 'Wind Speed']
e ooy Lo W TGy WO Wb WOy
0 PT_XYZ0342 ey 365 01 100 365.0 3700 369.0 680 930 70
1 PTovzoasy TSNS s 01 100 365.0 3700 3700 88.0 930 6.0
2 PT_XvZ0342 e 364 0.1 100 364.0 3710 3700 68.0 9.0 60
3 PT_XYZ0342 e 364 0.1 10.0 364.0 3460 3710 68.0 90.0 0.0
4 PT_XvZ0342 Tee 1 000 0.1 100 0.0 00 7.0 67.0 93.0 0.0
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c. Rename columns with shorter names. Create a smaller dataframe, modellingData,
containing only the values need for predicting transformer loads. Select this cell and hit
Shift+Enter.

# Rename some columns with shorter names to make them easier to work with.
poleTransformerLoads.rename (columns

poleTransformerLoads. rename (columns
poleTransformerLoads.rename (columns
poleTransformerLoads.rename (columns
poleTransformerLoads.rename (columns
poleTransformerLoads.rename (columns
poleTransformerLoads. rename (columns

{'Name® :'Transformer'}, inplace = True)

{'Wh Delivered Load':'Wh Load'}, inplace = True )

{'Wh Delivered Load - 14d':'Wh Load-14d'}, inplace = True )
{*Wh Delivered Load - 7d':'Wh Load-7d'}, inplace = True )
{'ambient Temperature':'Temperature'}, inplace = True )
{ -

{

'Relative Humidity':'Humidity'}, inplace = True )
'Wind Speed':'Wind'}, inplace = True )

L T [ [ [y [

# Define se dat

modellingData = poleTransformerlLoads[['Transformer', 'Timestamp', 'Temperature', 'Humidity',
'Wind', 'Wh Load', 'Wh Load-7d', 'Wh Load-14d']]

aframe with just data

# Peek at the first five rovs to make sure things look right
modellingData.head ()
Transformer Timestamp Temperature Humidity Wind WhLoad Wh Load-7d Wh Load-14d
0 PT_XYZ0342 2017-06-15 00:00:00 68.0 930 70 365.0 370.0 369.0
1 PT_XYZ0342 2017-06-15 01:00:00 68.0 930 6.0 365.0 370.0 370.0
2 PT_XYZ0342 2017-06-1502:00:00 68.0 930 6.0 364.0 371.0 370.0
3 PT_XYZ0342 2017-06-15 03.00:00 68.0 900 0.0 364.0 346.0 3710
4 PT_XYZ0342 2017-06-15 04:00:00 67.0 930 0.0 0.0 0.0 70

d. Change the index of modellingData to be the transformer name. Select this cell and hit
Shift+Enter.

# In order to analyze transformers individually, ve need toc set the datframe's index to the "Transformer"™ column.

modellingData = modellingData.set_index ("Transformer", drop=False)

# Take a loock, see the difference?

modellingData.head

Transformer Timestamp Temperature Humidity Wind Wh Load Wh Load-7d Wh Load-14d

Transformer
PT_XYZ0342 PT_XYZ0342 2017-06-15 00:00:00 68.0 930 7.0 365.0 aro.0 369.0
PT_XYZ0342 PT_XYZ0342 2017-06-1501:00:00 68.0 930 60 365.0 aro.0 370.0
PT_XYZ0342 PT_XYZ0342 2017-06-15 02:00:00 68.0 930 6.0 3640 o 3700
PT_XYZ0342 PT_XYZ0342 2017-06-15 03:00:00 68.0 900 00 364.0 346.0 370
PT_XYZ0342 PT_XYZ0342 2017-06-15 04:00:00 67.0 930 00 0.0 0.0 70

e. Leverage the connection to Pl OLEDB Enterprise and My Pole Transformer
Loads view to get the list of transformer names. Select this cell and hit Shift+Enter.
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f.
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# Use our existing PI Viev connectiont to select just the transformer names from the viev configured in
# PI SQL Commander.
PI_cursor.execute ("'SELECT DISTINCT Name FROM [Distribution Network].[Asset].[Pole Transformer Loads]"')

# Create a list for the transformer names.
transformerNames = []

# Populate the list
for row im PI_cursor:
10 transformerNames.append (row[0])

# Shov tranfomer names list.
print (transformerNames)

['PT_X¥z0342', 'PT_X¥20343', 'PT_X¥z0344', 'PT X¥z0345', 'PT_XYz0346', 'PT XYz0347', 'PT_XYz0348', 'PT_K¥Z0348', 'BT_
XYz0350', 'PT_X¥2z0351', 'BT_X¥z0352', 'PT_X¥z0353', 'PT_X¥20354', 'BT_XYz0355', 'BT_Xvz0356', 'PT_X¥20357', 'BT_X¥z03
S8', 'PT_XYZ0376', 'PT_XYz0377', 'PT_XYz0378', 'PT_X¥Z037%', 'PT_XYz0380', 'PT_X¥z0381', 'BT_X¥Z0382', 'PT_XYz0383',
'PT_X¥Z0384', 'PT_X¥Z0385', 'PT_X¥z0387', 'PT_X¥z0388', 'PT_Xvz0389', 'PT_X¥20390', 'PT_X¥z0391', 'PT_X¥20392', 'PI_X
¥20393", 'PT_X¥z0394', 'PT_XY20395', 'PT_X¥z0396', 'PT_X¥z0397', 'PT_X¥z039E', 'PT_X¥z0398', 'PT_Xyz0400', 'PT_X¥2040
1', 'PT_X¥z0402', 'PT X¥z0403', 'PT_XY20404', 'PT XYz0405', 'PT_XYz0406', 'PT_XYZ0D407', 'PT_X¥Z0408', 'PT_X¥20409',

'PT_x¥z0410', 'PT_X¥20411', 'PT_X¥z0412', 'PT_X¥z0413', 'BT_X¥20414', 'PT_X¥z0415', 'PT_X¥z0416', 'BT_Xy20418', 'PI_X
¥Z0418', 'PT_X¥20420']

Generate linear regression model coefficients for each of the 60 transformers and
write them to SQL. Select this cell and hit Shift+Enter.

¢# Using the "adodbapi" package, to connect to the "Predictive Equations" MS SQL.

# Set connection paramesters.
4 con_string = 'DRIVER=({SQL Server);SERVER=PISRV01;DATABASE=PIWorld:Trusted Connection=Yes;'

SQL_connection = ado.connect(con_string)

# Create a cursor object to access the data serer for the "Distribution Network Lab™ database in AF.
SQL_cursor = SQL_connection.cursor()

12 # Create linear regression object from the "sklearn”™ package ve imported earlier,
1 LinReg = LinearRegression()

15 # Looping through the trasformer list, Perform linear regression on esach transformer.
16 for transformer in transformerNames:

# Create dataframe for one transformer.
transformerData = modellingData.loc[transformer,:]

21 # Perform linear regression fit
22 LinReg.fit(transformerData({"Wh Load-7d", "Wh Load-14d","Temperature”, "Humidity"]],transformerData("Wh Load"])

24 # Update asset ID value vith the name of this transformer.
asset_id = "'"s+transformer+*'"

27 # Print equation.

B print (transformer, "Eq:\n", LinReg.coef [0], "*","'Wh Delivered Load - 7d' + ",LinReg.coef_[1],
“e%,"'Wh Delivered Load - 144' + ", LinReg.coef [2], "*", "'Ambient Temperature' +",
LinReg.coef [3], "*","'Relative Humidity' +(",LinReg.intercept , ")" )

32 ## INSERT and UPDATE queries to load table for the first time or update an existing one.

3 # Construct qQuery to add this transfomer's model coefficients.
34 insert_query = f£'INSERT (Predictive Equations] ([Asset ID], Coefficient 0, Coefficient 1, Coefficient_2, Coeffic
€ update_query = £'UPDATE [Predictive Equations] SET Coefficient O={LinReg.coef_ [0]}, Coefficient_ l={LinReg.coef [

¢ Insert this record into the "Predictive Equations” table.
SQL_cursor.execute (update_gquery)

41 ¢ Commit the queries to vrite the dats into SQL.
42 SQL_connection.commit ()

44 # Closes database connections.
45 SQL_connection.close()
46 PI_connection.close()
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PT_XYZ0407 Eq:
©.22133353596401245 * ‘wh Delivered Load - 7d' + ©.18948221947528418 * 'Wh Delivered Load - 14d' + 383.2482562187521 * 'Am
bient Temperature' + 7.845159867779784 * 'Relative Humidity' +( -14852.8518428231 )

PT_X¥Z@408 Eq:

©.22918154817171893 * 'Wh Delivered Load - 7d" + ©.1723254202743876 * 'Wh Delivered Load - 14d" + 287.3195523887@802 * 'Amb
ient Temperature' + 5.7839@9412754433 * "Relative Humidity' +( -8273.493697771371 )

PT_XYZ0409 Eq:

0.27065558508527234 * 'Wh Delivered Load - 7d' + ©.24888484285129917 * 'Wh Delivered Load - 14d' + 257.19175848719324 * 'Am
bient Temperature' + 37.677732512@0764 * 'Relative Humidity' +( -15786.690575218732 )

PT_X¥Z841e Eq:

0.28804834752338854 * ‘wh Delivered Load - 7d" + ©.23893391851491846 * "Wh Delivered Load - 14d” + 472.1167@533964144 * A
mbient Temperature' + 27.87650630785805 * 'Relative Humidity' +( -24316.385741388473 )

PT_X¥Z@411 Eq:

9.435860138307828 * 'Wh Delivered Load - 7d' + ©.41330607308063046 * 'Wh Delivered Load - 14d' + ©.3500444851848645 * 'Amb
ient Temperature® + ©.3106062465241230 * 'Relative Humidity' +( -34.91262860815301 )

PT_XYZ0412 Eq:

0.2075887778891295 * 'Wh Delivered Load - 7d' + ©.20641741419115514 * 'Wh Delivered Load - 14d' + 321.2758186735902 * 'Amb
ient Temperature' + 36.830485127504884 * 'Relative Humidity' +( -17855.728444950821 )
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Appendix B - Python Access to Pl via Pl Web API

Develop the Model in Python

The Pl Web API is installed with the Pl System. It provides programmatic access to the Pl

Archive and PI AF. The following script imports the same dataset used in Example 2 using the
Pl Web API.

By default, there is a constraint placed on calls made to the Pl System
when using the Pl Web API. Each call can return no more than 150,000
items. The type of items returned depends on the nature of the call. For
example, your maximum items could consist of elements, attributes, or
time series data values depending on how your call is defined.

This restriction can be adjusted by adding or resetting the

Tip “MaxReturneditemsPerCall” attribute value under the Pl Web API
branch of the Configuration database on your AF Server. More
information can be found on page 3 of the Pl Web API 2018
Users Guide.

a. Import Python packages for supporting Pl Web API session and managing message
requests and unpacking json responses. Select this cell and hit Shift+Enter.

import adodbapi as ado
import pandas as pd
from sklearn.linear mcdel import LinearRegression # Lir

import json, requests, urllib.parse, requests kerberos # Sur

from requests_kerbercs import HTTPEerberosAuth, OPTIONAL
clientAuth = HTTPRerbercshuth (force preemptive=True, mutual_ authentication=OPTIONAL, delegate=True)

requests.packages.urllib3.disable warnings ()

session = requests.session()
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b. Make a client connection to Pl via the Pl Web API. Select this cell and hit Shift+Enter.

# Connect to PI System at highest level.
print ('\nSending top level PI Web API Request\n'})

# Base URL to PI System.
baseurl = "https://PISRV0l/piwebapi/"

# Post URL to PI System and retrieve response.
response = sessiocn.get(baseurl, auth=clientfAuth, verify=False, timecut=30)

# Response status - did it work, i.e. 200 means success?
print ('Respense Received: {0} ' .format(respcnse.status_cocde), '\n')

# Unpack items of interest using the "json" package. Extracts dictionary of links.

Links = json.loads (response.text) ['Links']

# Extracts base level URL's for PI Web API from the Links dictionary using the "json" package.
print('Self:’, Links['Self'])

print ('Asset Servers:', Links['AssetServers'])

print ('Data Servers:', Links['DataServers'])

print ('PI System:', Links['System'], "\n')

Sending top level PI Web API Request
Response Receiwved: 200

Self: https://pisrv0l/piwebapi/

Asset Servers: https://pisrv0l/piwebapi/assetservers
Data Servers: https://pisrv0l/piwebapi/dataservers
PI System: https://pisrv01/piwebapi/system

c. Pl Web API Request for “Webld” of Colegio Cientifico circuit (parent) element.

# Get WebId for circuit element, "Colegioc Clientifico”.

# Root path to "circuit" level in AF heirarchy.
circuitPath = *\\\\pisrv0il\\Distribution Network\\Alajuela\\Avenida Central\\Transformer 1\\Colegioc Cientifico'

# Construct URL to the Get Elements controller of the PI Web API.
baseurl elements = baseurl + '/elements'

# Set parameters list by specifying the AF path to the circuit's element.
parameters = {'path': circuitPath, }

# Format parameter list for URL.
url_parameters = urllib.parse.urlencede (parameters, quote via=urllib.parse.quote)

# Showv HTTPS request string.
print ("PI Web API Request for WebId of Colegio Cientifico. Click it to see the respomnse from PI.\m\n', \

baseurl elements + '?' + url_parameters, '\n')

# Post URL wvith path and paramters to PI System
response = session.get(baseurl elements, auth=clientAuth, params=url_parameters, verify=Palse, timeout=30)

# Response status - did it work?
print ('Respcnse Received: {0} ' .format(response.status_code}, '\n')

# Shov element's Web Id.
circuitWebId = json.loads (response.text) ['WebId']
print ("Colegio Clientifico element's WebId:\n", circuitWebld)

PI Web API Request for Webld of Ceclegic Cientifico. Click it to see the response from PI.

https://PISRV01/piwebapi//elements?path=%5C%5Cpisrv01%5CDistribution%20Network%5CAlajuelat5CAvenida%20Central®5CTran
sformer%201%5CColegio%20Cient%C3%ADfico

Response Receiwved: 200
Colegic Clientifice element's WebId:

FlEm BJ6yxOWfEulXNE8dxGowlglda SqpOséBGBIQANO]YEWWUELITULYwMVXESVNUUkLCVVRJITO4gTkVUVOSSS1xBTEFEVUVMOVXBVKVOSURBIENFT1IRS
QUxcVFJIBT1INGT 1INRVIgMVxDTOxFRO1PIENJRUSUw4 LGSUNP
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For this example, we launched Jupyter Notebooks in Google Chrome.
In Chrome, hyperlinks printed from Python are active and when
clicked will open an adjacent browser window allowing you to see
. messages returned from the Pl Server. This is a very handy feature for
Tip debugging your script.

Clicking the hyperlink in the Python output shows the response message from the Pl Web
API.

Help pages: PI Web APT Help » Element > GetByPath

"F1EMXY@I K1o_UameutkfRTIKNQSK 7gw7 agEBGAVRAL thuPogQehFULRMRVI SNDUWXER JULRSSUIVVELPTLB0RVRXT1ILIEXBQLXBTEFKVUVHQUXBVKVOSURB LENF T1RSQUXCVF I6TING T INRVIgHVXDTX FRA1PIENIRUSUNA1GSUNF ",
Jeddefs-abbb-11e8-9d55-1802656c0Fa2",

“Colegio Cientifico”,

"pescription”;
“Path” ‘p'\\\\ HERTLER7450\ \Distribution Hetuork Lab\\Alajuela\\Avenida Central\\Transformer 1\\Colegio Cientifico™,
"Templatename”: "Circuit”
"HasChildren": true,
“Categoryfames”: [

"Circuit Regulated”

1,

ExtendedProperties®: {},

“Links
“Self": “https://chertler7450.osisoft,int/p:

"Analyses Tt ! .int/piwsbapi/elements/F1EMXY@IK1o_UembwHicFREIKNQIkT gu7 3gEBGAVRACT]

bapi/elements/FIEmXY@IKlo UeménikfREIKNQ2kT gu7ag6BGHVRAC IExBQLxBTEFKVUVIQYXBYKVOSURBT ENFT1RSC
BOLXBTEFKVUVHOU XBVKVOSURE LENF |

<y 574

"Interpolatedbata”:
"RecordedData™:
“PlotData”: i

“attribut hsrtler74se osizoft. bopi/clements/FIEMOIK10_UOnGu1kFRYIKNODLT g7 HRY] VRXT QLB TEFKVUVIMQYxBY KVOSURBIEN
“Elements [chertler7450. o pi/elements/F1ERXYOIKlo_UBmewHicFRYJKnQSk 7 gw7ag6BGAVRACH chBhFJLHHRVB‘IDUNKER‘UHSSU VVELPTiBORVRXT1] LTEXBOLxBTEFKVUNMOVxBVKVOSURBTENFT]
"Database [chertler7450. o bapl/assetdatabases /FIRDXY@IK10 Udm 18 PolxS- nnﬂBTFJlR"RVI‘I\DIJ -XE 1RSSUIVVEIPTiBORVRXT1JLIEXEQE™,
"Parent”: "https://chertler7450, osisoft, int/piwebapi/clements/FIEmXVOIKlo UinbullkFRIKNQEE7E) ACERPo 0! HRVI 3N YELPT] ! )
“Template": "https: chsr:ler?ﬂ@ms.,qf..m: piwebapi/elementtemplates/F1ETXY@IK10 UBmbu k’RtJKn@QIFbu SUiekshor nLFAQ@hFJlRIIMISNJU JUIRSSUIVVE1PTiBORVRXT1)LTEXBOLXFTEVNAUSI
"Categories! https rtler745. /piwebapi/elensnts /F1EMXYBIK10_UBmEnikfRt IKNQIkT grT: T E /]
“EventFrames ch:rtl:r.4se o5i bapi/elenents/F1EnXYBIK1o U kth.KnQ

s://chertler?48a. osisoft. int/piwebapi S/F1Em u

I

hertler7259. 0z sof [pduel Y8

Rsi//chertler7450.0sisoft, int/, uLLL_n_z.La_lj_ﬁ.mg_LLiu_k_LL
[chertler?45@.0sisoft.int/piwebapi/streamsets/F1EmXY8lKlo Lams.nkfut]mqgw
1kFRE

"SummaryData": "https://chertler745@.osisoft. int/piwehapi/streamsets/F1EMXYBIK10_Ubmbut VRAC ThiPOgQBhEULR!
"Value™; " [¢chertler7450, osizof! inebapi/streamsets/F1EmXY8IK1o UsmBulkfRIIK) ACEUPoRQRhFULRY JXERIVIE! i DlnETUMU!"WEBMSEEL!REIEMTI
*Endvalue iwebapi/streansets/F1EnXY@lk1o_UbmutcFtt ISk guTagEBGIVRAL thinPogQBhFU ARV SHDLXERIU RSS TVVELPT 3 BORVRXT 1L 1ExBQ LB EFKVUVMOU BV KVOSURBTEN
"security”: piweba, snents/FIEMXYBIK w1k FRE IKNO3k7 g7 aR6BGAVRAC thinPogQehFULRMRVI INDUMXER JUIRSSUTVVELPT RAT 1B TEFKVUNMOUXBVRVOSURBTENF]

17 apEBGAVRAC thinPog08hFULRMRYVI INM X ERIUIRS SUIVVELPT DRVRXTULIExEleBTEFK\JLN“OVKEVWDS

hety
"SecurityEntries”: "https://chertler7450,osisoft. int/pivebapi/elements/FIEnXYBIK1o UbmbulkfRtIKnOIKT,
PogQPhFUIRMRYT INDUWXER U1 RSSUIVVE] PT 1 BORVRXT 111 TExBQ1xBT EFKVUVHOVeBVivd]

"NotificationRule: https://chertler745e.osisoft.int/pinehapi/elenents/F1EMXYAIK10_LBmbnkTRT IKNQTKT|

Pl Web API Request for “Webld™'s of X, Y and Z Phase (child) elements.

# Get names and Webld's for phase elements under the "Colegio Cientifico™ circuit elsment.

# Define dictionary to store the names and WebId's for the three phasa elements
4 phaseElements = [}

# Construct URL to all child elements of rcuit "Colegic Cientifico™ using it's WeblId.

baseurl_elements = baseurl + '/elements/' + circuitWebId + '/elements"'

# Request names and Webld's for sll child elements derived from the "Fhase" template.
parameters = {'templateName': 'Phase’, 'selectedFields’:'Items.Name;Items.WebId'}

& Format parameter list for URL
url_psrameters = urllib.parse. urlencode(parameters, quote_via=urllib. parse quote)

# Show HTTPS request string.
print{"PI Web API Request for WebId's of X, Y and Z Phase elements.”, \
"Click it to see the response from PI.\n\n", baseurl_elements + '?' + url_parameters, '\n'}

# Post URL with path and paramters to PI System
response = session.get (baseurl_elements, auth=clientAuth, params=url_parameters, verify=False, timeout=30)

& Response status - did it work?
print{'Response Received: {0} ' .format(response.status_code), '\n')

& Loop throught he response to pupulate the phaseElsments dic
for item in json.loads(response.text) ['Items']:

# Stors the strings.
phaseElements.update ({item['Name']:item[ 'WebId']])

# Print the WebIds nsing the Name index
print ("X Phase's WebId:\n", phaseElemsnts(['X Phase'l)
print{"Y Phase's WebId:\n", phaseElemsnts['Y Phase'l)
34 print{"Z Phase's WebId:\n", phaseElements['EZ Phase'l)

PI Web API Request for Webld's of X, ¥ and Z Phase elements. Click it to see the response from PI.

https://PISRV0l/piwebapi//elements/F1Em_BJeyxOWfEulXNBdxGowlgda_SgpOs6BGBFOANO] YEWWUELTULYWMVESVNUUk1CVVRJITO4gTkVUV
0955 1xBTEFKVUVMQVXBVEVOSURBIENFT1RSQUxcVFJETINGT1 INRVIgMVxDT OxFRO1PTENTRUSUw 1GSUND /e lements 7templateName=Phaszesselec
tedFields=Ttems Name%3BItems WebId

Response Received: 200

X Phase's Webld:

FlEm BJEyxOWLEulXN8dxCGowlg4é_SqpOsEBGEFQANO ] YKWwUELTUL YwMVRESVNUUK LCVVRIT04gTkVUVO 9SS 1xBTEFKVUVHQVxBVKVOSUREIENFT1RS
QUxcVFIBT1NGT 1 JRRVIgMVxDT 0xFROLPIENJRUSUw4 1GSUNPXFggUERBUOT
Y Phase's Webld:

FlEm BJ6yxOWfEulXN8dxGowlgehQfuS0s 6BGEFQANO] YKWwUELTUL ¥YwiMVxE SVNUUK 1CVVRIT04gTkVUV095S1xBTEFKVUVMQVxBVKVOSUREIENET1RS
QUxcVFIBT1NGT 1 JNRVIgMVxDT 0xFROLPIENJRUSUw4 1GSUNPKFkgUERBUOT
Z Phase's Webld:

FlEm BJ6yxOWfEulXN8dxGowlgBEkfuS0s 6BGEFQANO] YKWwUELTUL ¥YwiMVxE SVNUUK 1CVVRIT04gT kVUV0 9SS 1xBTEFKVUVMQVxBVKVOSURBIENEFT1RS

L QUsxcVEIBTINGT1 JHRVI g DT 0xFROLIPIEN JRUS U4 1 CSUNEXFoqUERBU 0T
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f. Define an empty dataframe named modellingData and list name allTransformers
to write the transformer data and names into. Select this cell and hit Shift+Enter.

4 das dataframe for transformer data.
columns =['Transformer', 'TimeStamp', 'Temperature', 'Humidity"','Wind', 'Wh Load', 'Wh Load-14d', 'Wh Load-7d']
modellingData = pd.DataFrame (columns=columns)

g. We will step through each Phase, X, Y and Z. For each phase, we will loop through
each transformer, appending its attribute values to the dataset. Select this cell and hit
Shift+Enter.

o i:ohaseﬁebtd in phaseElements.items():

ed URL to reference each phase element.

erencedelements = baseurl + '/elements' + '/' + phaseWebld + '/referencedelements'

oot

baseurl re

" template.

I3
'Items.Name; Items.WebId'}

1ts derived from the "Single Phase Transfrme

'"Single Phase Transformer','selectedFields

# Request fi
parameters

r list for URL.

urllib.parse.urlencode (parameters, quote_via=urllib.parse.quote)

# Format param

url parameters

# Show HTTPS request strin
if printURL:
print ("Sample PI Web API request for Name and WebId's of transformers under”,\
phaseName, ' Click it to see the response from PI.\n\n', \
baseurl referencedelements + '?' + url parameters, '\n')

w

# Post URL with path and paramters to PI System

response = session.get (baseurl referencedelements, auth=clientAuth, params=url parameters, verify=False, timeo

# Response status - did it work?
print ('Response Received: {0}' .format(response.status code),"Transformer Name and WebID's for", phaseName,

"\n

£

# Define\s

transformerElements

# Loop thr

for item in j=cn.loads (response.text) ["Items']:

# Store the strings.

transformerElements.update ({item['Name']:item["WebId']})
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35 # Loop through phases.
40 for transformerName, transformerWebId in transformerElements.items():

# Add this transformer to the list.
allTransformers.append (transformerName)

# Construct URL for getting selected attributes.
baseurl multipleattributes = baseurl + '/attributes/multiple’

# Request WebId's for specified transformer attributes.

parameters = [('Path', circuitPath + '\\' + phaseName + "\\' + transformerName + '|Ambient Temperature'), \
('Path', circuitPath + '\\' + phaseName + "\\' + transformerName + '|Relative Humidity'), \
(*Path’', circuitPath + '\\' + phaseName + '\\' + transformerName + '|Wh Delivered Load'), \
('Path', circuitPath + '\\' + phaseName + "\\' + transformerName + '|Wh Delivered Load - 14d"]
('Path’', circuitPath + '\\' + phaseName + '\\' + transformerName + '|Wh Delivered Load - 7d'),
('Path', circuitPath + '\\' + phaseName + '\\' + transformerName + '|Wind Speed'), \

('SelectedFields’', 'Items.Object.Name; Items.Object .Webld')]

# Format parameter list for URL.
url_parameters = urllib.parse.urlencode (parameters, gquote via=urllib.parse.quote)

# Show HTTPS request string
if printURL:
print ("Sample PI Web API request for Name an WebId's of", transformerName, "'s selected attributes.", )\
' Click it to see the response from PI.\n\n', baseurl multipleattributes + '?' + url parameters, "'\1

# Post URL with path and paramters to PI System.
response = session.get(baseurl multipleattributes, auth=clientAuth, params=url parameters, verify=False, t:

1

# Response status - did it work?
print (" Response Received: [0}' .format (response.status code),"Attribute Name and WebId's for™, \
( transformerName, '\n')

1 Y
0 o

# Define list for attribute Webid's.
attributeWebId = []

75 # Loop through unnamed list and extract WebId and Name intc lists.
& for attributes in json.loads(response.text) ['Items']:

attribute = attributes['Object']
attributeWebId.append(attribute['Webld"'])

# Construct URL for getting interpoated data for attributes.
baseurl streamsets = baseurl + '/streamsets/interpolated’

# Request for start and end times, and interval.
parameters = [('WebId', attributeWebId[0]), ('Webld', attributeWebId[1]),\
('WebId', attributeWebId[2]), ('WebId', attributeWebId[3]),\
('WebId', attributeWebId[4]), ('WebId', attributeWebId[5]),\
{'startTime', "15-jun-2017"), ("endTime"', "31-aug-2017"), ("interval’,"1h") ,\
({'selectedFields', 'Items.Name;Items.Items.Timestamp;Items.Items.Value')]

# Format parameter list for URL.
url parameters = urllib.parse.urlencode (parameters, quote_via=urllib.parse.quote)

# Shov HTTPS request string
if printURL:
print ("Sample PI Web API request for Timestamp and Values for transformer's selected attributes.”",\
' Click it to see the response from PI.\n\n', baseurl streamsets + '?' + url parameters, '\n')

# Post URL with path and paramters to PI System
response = session.get(baseurl streamsets, auth=clientAuth, params=url parameters, verify=False, timeout=3(

# Response status - did it vork?
print (' Response Received: {0}' .format(response.status code), "Attribute Timestamp and Values for", A

transformerName, "\n'}
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108 # Initialize lists to store unpacked data.
10 transformer = []; timestamp = []; temperature = []; humidity= []; wind = []
B load = []; load_14d = []; load 7d = []

# Loop through response and create pandas dataframe for this transformer.
111 # For each attribute.
112 for attribute in json.loads(respcnse.text) ['Items']:

# For each teimstamp\value.
for value in attribute['Items="]:

# Store values for “Ambient Temperature" attribute into its list.
if attribute['Name'] == 'Embient Temperature':
119 temperature.append (value['Value'])

# Fill timestamp and transformer name lists here, only need to do this once.
timestamp.append(value['Timestamp'])
transformer.append (transformerName)

" attribute into its list.

# Store values for “Relative Humidity
if attribute['Name'] == "Relative Humidity":

humidity.append(value['Value'])

129 # Store values for "Wind Speed™ attribute into its list.
if attribute['Name'] == 'Wind Speed':
wind.append (value['Value"])

# Store values for "Wh Delivered Load" attribute into its list.
if attribute['Name'] == 'Wh Delivered Load':
35 load.append(value['Value'])

137 # Store values for "Wh Delivered Load - 14d" attribute into its list.
138 if attribute['Name'] == 'Wh Delivered Load - 14d':
39 load l4d.append(value['Value'])
40
# Store values for "Wh Delivered Load - 7d" attribute into its list.
if attribute['Name'] == 'Wh Delivered Load - 7d':

load 7d.append (value['Value'])

# Put lists of data for this transformer into a temporary dataframe

14 'Humidity':humidity, 'Wind':wind, 'Wh Load':load, 'Wh Load-14d':load 14c¢
48 "Wh Load-7d':lcad 7d})

thisTransformerData = pd.DataFrame ({'Transformer':transformer, ‘TimeStamp':timestamp, 'Temperature':temperai

# Add this transformer's data to the others.

modellingData = pd.concat ([modellingData, thisTransformerData],ignore index=True)

# Turn off URL printing.
printURL = False

# Print end of dataframe to see if ve got all 110,940 records(row index of 110,939).
modellingData.tail (5)

h. Scroll down the results window to see the phase steps and transformer loops used to
build the dtataframe. At the very bottom inspect the last five records to confirm all 110,
939 have been extracted.

Humidity Temperature TimeStamp Transformer Wh Load Wh Load-14d Wh Load-Td Wind
110935 73.0 68.0 2017-08-31T03:00:00Z PT_XYZ0414 69.0 440 680 70
110936 81.0 64.0 2017-08-31T04:00:00Z PT_XYZ0414 68.0 450 680 30
110037 75.0 66.0 2017-08-31T05:00:00Z PT_XYZ0414 68.0 450 69.0 30
110038 78.0 65.0 2017-08-31T06:00:00Z PT_XYZ0414 67.0 46.0 680 30
110939 86.0 62.0 2017-08-31T07:00:00Z PT_XYZ0414 68.0 440 69.0 30
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Generate linear regression model coefficients for each transformer and write them to
SQL. Select this cell and hit Shift+Enter.

# In order to analyze transformers individually, we need to set the datframe's index to the "Transformer™ column.
modellingData = modellingData.set_index("Transformer", drop=False)

# Set connection parameters.
con_string = 'DRIVER={SQL Server}; SERVER=PISRV(0]; DATABASE=PIWORLD; Trusted Connection=Yes;'

# Connect to "Distribution Netvork Lab" model in AF through the PI SQL Client.
SQL_connection = ado.connect(con_string)

# Create a cursor object to access the data serer for the "Distribution Netvork Lab" database in AF.
SQL_cursor = SQL connection.cursor()

# Create linear regression object from the "sklearn™ package ve imported earlier.
LinReg = LinearRegressiocn()

# Looping through the trasformer list, Perform linear regression on each transformer.
for transformer in allTransformers:

# Create dataframe for one transformer.
transformerData = modellingData.loc[transformer,:]

# Perform linear regressicn fit
LinReg.fit (transformerData[["Wh Load-7d","Wh Load-14d", "Temperature", "Humidity"]],transformerData["Wh Load"])

# Update asset ID value vith the name of this transformer.
asset_id = "'"+transformer+"'"

# Print equation.

print (transformer, "Eg:\n", LinReg.ccef (0], "*","'Wh Delivered Load - 7d' + ",LinReg.cocef [1], "*","'Wh Deliver
LinReg.coef [2], "+", "'Ambient Temperature' +", LinReg.cocef [3], "*", "'Relative Humidity' +(",LinReg.intercept |

## INSERT and UPDATE gueries tc load table for the first time or update an existing one.
# Construct gquery to add this transfomer's model coefficients.

insert_gquery = f'INSERT [Predictive Equaticns] ([Asset ID], Coefficient 0, Coefficient_1, Coefficient_2, Coeffic

update_query = f'UPDATE [Predictive Equations] SET Coefficient_ O={LinReg.coef_ [0]}, Coefficient_1={LinReg.cocef_ [

# Insert this record into the "Predictive Egquations" table.
SQL_cursor.execute (update_guery)

# Commit the queries teo write the data into SQL.
SQL_connection.commit ()

# Close database connections.
SQL_connection.close()
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Appendix C — Learning Resources

Pl Resources

Pl Integrator for Business Analytics (YouTube Playlist)

Exposing Pl Data with the Pl SOL Framework (Online Course)

Programming in Pl Web API (Online Course)

Jupyter Resources

Jupyter Notebook for Beginners: A Tutorial

Jupyter Notebook Tutorial: The Definitive Guide

Jupyter Notebook Cheat Sheet

Jupyter Notebook Keyboard Shortcuts

28 Jupyter Notebook tips, tricks, and shortcuts

Machine Learning Resources

The table below contains a collection of learning resources | have experience
with Course | Topic: Abbreviated title and hyperlink of learning resource Type:
Course or Book

Language: Programming language used in the course

Platform: Course provider

Complexity: (1 introductory) - (5 bleeding-edge) ) .
Curve: Learning-curve or approachability of the material (1 requires strong background

knowledge) - (5 easy to follow given the complexity)

H
Theoretical: Theoretical coverage of algorithm details (1 few details) (5 in-depth
explanations)

Practical: (1 difficult to apply to project) - (5 readily applicable to real-world scenarios)

Course | Topic Platform | Complexity Curve Theoretical Practical

Data Science

Course  Python Udemy 2 5 2 4

Bootcamp
The Analytics Edge Course R edX 3 5 4 4
iS.r':al:;clstlcal Learning Book R Book 3 5 5 5
Machine Learning Course Matlab Coursera 3 4 5 4
TensquIow Deep Course  Python Udemy 3 4 2 3
Learning
N IN ks f

.1 Hete/orks “or Course  Python Coursera 3 3 5 3

Machine Learning
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https://www.youtube.com/playlist?list=PLMcG1Hs2Jbcv_U_Uc0rz1XohWJizyEcET
https://pisquare.osisoft.com/community/Learn-PI/exposing-pi-data-with-the-pi-sql-framework
https://pisquare.osisoft.com/community/Learn-PI/programming-in-pi-web-api
https://www.dataquest.io/blog/jupyter-notebook-tutorial/
https://www.datacamp.com/community/tutorials/tutorial-jupyter-notebook
https://s3.amazonaws.com/assets.datacamp.com/blog_assets/Jupyter_Notebook_Cheat_Sheet.pdf
https://www.cheatography.com/weidadeyue/cheat-sheets/jupyter-notebook/pdf_bw/
https://www.dataquest.io/blog/jupyter-notebook-tips-tricks-shortcuts/
https://www.udemy.com/python-for-data-science-and-machine-learning-bootcamp/
https://www.udemy.com/python-for-data-science-and-machine-learning-bootcamp/
https://www.edx.org/course/analytics-edge-mitx-15-071x-3
https://www.amazon.com/Introduction-Statistical-Learning-Applications-Statistics/dp/1461471370/
https://www.amazon.com/Introduction-Statistical-Learning-Applications-Statistics/dp/1461471370/
https://www.coursera.org/learn/machine-learning
https://www.udemy.com/complete-guide-to-tensorflow-for-deep-learning-with-python/
https://www.udemy.com/complete-guide-to-tensorflow-for-deep-learning-with-python/
https://www.coursera.org/learn/neural-networks
https://www.coursera.org/learn/neural-networks

Exploring AF Analytics for Advanced Analysis and Prediction

Deep Learning Learnlng
Course Python Coursera
Specialization

---_

Practical Deep & byth S
Learning For Coders — ython as

---—

Deep Learning Book Python Book

Time Series Analysis Course Unknown

Join Kaggle! A vibrant machine learning community with over 13,000 datasets to practice on
and learn from others. Kaggle has many community-made tutorials for beginners, competitions
with rewards (such as the $1.5 million Homeland Security Passenger Screening Challenge),
and many examples of bleeding-edge machine learning algorithms.

73| Page


https://www.amazon.com/Hands-Machine-Learning-Scikit-Learn-TensorFlow/dp/1491962291/
https://www.amazon.com/Hands-Machine-Learning-Scikit-Learn-TensorFlow/dp/1491962291/
https://www.coursera.org/specializations/deep-learning
https://www.coursera.org/specializations/deep-learning
http://forums.fast.ai/t/another-treat-early-access-to-intro-to-machine-learning-videos/6826
http://forums.fast.ai/t/another-treat-early-access-to-intro-to-machine-learning-videos/6826
http://course.fast.ai/index.html
http://course.fast.ai/index.html
https://www.amazon.com/Deep-Learning-Python-Francois-Chollet/dp/1617294438
https://www.amazon.com/Deep-Learning-Python-Francois-Chollet/dp/1617294438
https://www.amazon.com/Deep-Learning-Adaptive-Computation-Machine/dp/0262035618/
http://course.fast.ai/part2.html
http://course.fast.ai/part2.html
https://www.edx.org/course/time-series-analysis-0
https://www.edx.org/course/big-data-analytics-using-spark-uc-san-diegox-dse230x
https://www.edx.org/course/big-data-analytics-using-spark-uc-san-diegox-dse230x
https://www.kaggle.com/

Have an idea how to
improve our products?

OSlsoft wants to hear
from you!

https://feedback.osisoft.com/

AR
4
A
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OSlsoft.

PlWorld

Save the Date!

OSilsoft Pl World Users Conference in Gothenburg, Sweden. September 16-19, 2019.

Register your interest now to receive updates and notification early bird registration opening.

https://pages.osisoft.com/UC-EMEA-Q3-19-PIWorldGBG-
ReqgisterYourlnterest RegisterYourinterest-LP.html? ga=2.20661553.86037572.1539782043-
591736536.1533567354

fg I%sisif}Vorld

GOTHENBURG
Sept. 16 - 19, 2019
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